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Introduction to ForexGridMaster Advanced

ForexGridMaster goes beyond the normal limits of MetaTrader 4 from MetaQuotes, and is built with Industrial
Strength code to put it on the leading edge of automated Forex trading. It truly is the Rolls Royce of grid trading
systems.

ForexGridMaster Advanced EA (Expert Advisor) was developed to enable traders to design and trade any
number of their own automatic trading system strategies, as well as those created and shared by others. All
ForexGM Advanced input settings are documented and easily configured by the trader. ForexGM was primarily
designed as a tool to develop and fine-tune algorithmic grid trading strategies that profit from price movements,
small or large, in either direction -- trend, counter-trend, range, scalping, news, or breakout trading. ForexGM is
also very versatile for precision semi-automatic manual trading, especially scalping. We are open to your ideas and
adding new features to ForexGM that promise higher and safer profits. Sample strategies and results are posted
on the Performance Page of the ForexGM web-site. Optimization Reports with viewing and download links for
some preset strategy files are provided for sharing at FORO (ForexGM Optimization Reports Online). Please note
that these links refer to results from earlier versions of ForexGM.

Matching specific ForexGM strategies with the most appropriate brokers can make a big difference to your
bottom-line, especially for scalping strategies. We have traded with more than twenty brokers since 2002, and the
choices continue to improve in favour of traders. Brokers are becoming more competitive, traders more aware, and
regulatory agencies more watchful. Now it is the norm to expect low spreads (1 pip or less for EURUSD), no or low
commissions, no re-quotes, instant execution, no trade restrictions such as pending order distance from current
price, 0-1 pip stop loss, 1 ms to 10 ms (or less) latency from VPS to broker server, etc. These are all important
aspects of Forex to learn and use to your advantage.

ForexGridMaster Advanced is user-friendly, and is also a very sophisticated software program with many options
that require time and practice for a user to fully appreciate all the possibilities. Be warned that the vast number of
combined settings with endless scenarios that result, may trigger a lot of brain-storming and fun. Gamers, take
note.

The contents of this document are purely for educational purposes and should never be considered as
investment advice. ForexGridMaster.com, its owners, staff, affiliates and associates, are not liable for loss or
damage of any kind which may arise directly or indirectly from the trading or use of any of the offerings from
ForexGridMaster.com, including Expert Advisor robots and all related information and material.
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ForexGridMaster User Guidelines

ForexGM Latest Build:

At the time of writing, the current version of ForexGM Advanced is v6.01 build 44. It will run on MetaTrader 4.00
build 1090 and above.

ForexGM Licensing:

ForexGM Advanced (full version) is licensed to a trader’'s Account-Name, allowing up to 3 real-money accounts
and 5 demo-accounts. ForexGM Advanced trial-version only works on demo-accounts. If any License changes are
required, these can be made by logging into your account at EAfactory.

Account Currency and Normalization:

ForexGM can trade any Account-Currency... USD, EUR, GBP, JPY, CHF, AUD, etc. ForexGM also integrates
conversion-pair currency calculations (Normalization). This enables more accurate results when using different
Account-Currencies trading the same strategy and same currency-pair on demo and real money accounts, or in
Strategy Tester. MetaQuotes does not yet acknowledge this issue and consequently Strategy Tester results
without Normalization can sometimes be inaccurate. For example, when trading AUDNZD using a USD Account-
Currency, the NZDUSD is the conversion-pair (ratio of Account-Currency USD to the NZD Quote-Currency).

This means that in Strategy Tester the M1 historical data must be loaded for NZDUSD as well as AUDNZD so
that ForexGM Advanced Normalization can provide the most accurate back-testing results. In Strategy Tester, the
NZDUSD price action is displayed on the bottom right of the chart. Same example but on a real money account,
the NZDUSD must also be listed in the Market Watch panel so that ForexGM will integrate the NZDUSD
conversion-pair price action in real time as well. Trading AUDNZD with NZD as the account-currency does not
require conversion, and when trading AUDNZD with AUD as the account-currency, the conversion-pair is AUDNZD
itself.

Decimal Places and Pips:

ForexGM Advanced automatically detects whether the broker uses 2, 3, 4 or 5 decimal places for price quotes.
As an example, Take-Profit Pips can be set to 17 pips regardless of whether the price quotes use 2, 3, 4 or 5
decimal places. In the case of the EURUSD as one example of 5th place decimal pricing, the 4th place decimal is
the pip and the 5th a fraction of a pip (called a point). If the EURUSD moves from 1.37010 to 1.37020, then it has
moved 1 pip or 10 points. If it moves from 1.37010 to 1.37011, then it has moved 1/10th of a pip or 1 point. For
currency-pairs with 3 decimal places, such as the USDJPY, if the price moves from 95.700 to 95.710, then it has
moved 1 pip or 10 points, and if from 95.700 to 95.701, then it has moved 1/10th of a pip or 1 point.

For trading instruments like Stocks, CFDs or crypto-currencies, the concept of a “pip” is less well defined. When
dealing with anything other than Forex, ForexGM normally treats a pip as 1 unit of quote currency — e.g. BitCoin
quoted in US dollars would use 1 pip = US$1.00.

Settings Changes:

When starting a new strategy or making major changes to an existing one beyond small variations to settings
that can be changed on-the-fly, it is best to rely on the philosophy, “New Strategy >> New Chart”. Removing
ForexGM from an old chart is ULTRA important because it clears the Global Variables associated with that
particular strategy on that particular chart. To close associated trades, use the MT4 "One-Click Trading Mode" for
fast delete of trades or perhaps the CloseAllINow option if the ForexGM EA is still functional on the chart.

Time-Frames:

ForexGM Advanced strategies are not time-frame dependent, meaning that any ForexGM strategy can be
traded on any time-frame and the only difference will be how well the trading action can be viewed. We
recommend using ForexGridMaster on the M1 time-frame for maximum visibility, and switch time-frames as desired
since this will not disrupt normal ForexGM function. Pending orders and open trades will also display on other
charts using the same currency-pair.

Leverage:

Some brokers will allow as much as 1:500 leverage or more on their accounts. This means that ForexGM can
trade a full standard lot of $100,000 using only $200 on margin, which is excellent for ForexGM, especially when
trading for high profit. Most grid-trading strategies need a healthy margin for flexibility, especially for Portfolio
trading. The leverage on the account that ForexGM is trading can be seen in the Experts log-file, usually a line or
two after ForexGM has been initialized. High leverage can be dangerous if a trader is not experienced and well
aware of potential negative consequences when setting strategies and managing money.
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Closing Orders:

Whenever many open or pending orders are triggered to close at the same time by Close-Run settings, it takes
time for the open trades and pending orders to all close. Price is moving continuously, so the closing prices will not
always be exactly those requested. In normal market conditions, the difference is usually relatively small.

Many Simultaneous Transactions:

The more open-trades and pending-orders there are on an active chart, the greater the chance of delayed
execution, especially if the latency of trade execution is more than 50 milliseconds. Also, not all brokers are the
same. There are many levels of technology involved -- the broker and their server, their MetaTrader environment,
the computer that ForexGM Advanced trades from, Internet connection, VPS environment, bank-feeds to the
broker, etc. MetaTrader4 executes only one line of code at a time per chart, and although infrequent, glitches can
occur, and it is important to keep a watchful eye until reliability has been proven.

We strongly recommend that all ForexGM strategies be first traded on a demo-account, and also back and
forward-tested using Strategy Tester with at least 2 year's tick-data. This will allow the trader to become familiar
with the large number of ForexGM settings and how they combine to produce effective and profitable strategies.
Best to start small when trading a real-money account. MetaTrader brokers are not all equal, and different brokers
may produce different results because of certain parameters they have set for their environment. However,
ForexGM Advanced is capable of trading reliably on most broker platforms for an indefinite period of time.

ForexGM EA Smiley-Face: @ = @

While ForexGridMaster is active and able to successfully transact with the broker's server, a small smiley-face
icon displays at the top right of the chart window. Click on that icon to open ForexGM’'s properties panel.
Alternatively, right-click in any clear area of the chart and in the pop-up panel that shows, choose “Expert Advisors
> Properties”. If an emergency situation arises and ForexGM cannot be accessed through property settings,
clicking the AutoTrading button on the top toolbar will disable ForexGM. Note that the AutoTrading button will
disable all EAs currently attached to charts in the terminal, not just the EA on the active chart. A subtle change in
the button-image indicates its status, and, because of its importance, ForexGM also displays additional information
to alert the trader when trading is not permitted. If all else fails, simply close the chart window and any open trades
and pending orders might need to be closed or deleted manually. When ForexGM is inactive, the smiley-face turns
red to indicate some user intervention may be required.

Preset Strategy Files:

When creating strategies for ForexGM Advanced using the input settings described below, they can be saved as
preset files in the “[MT4 Data Folder\MQL4\Presets” default directory, or “{MT4 Data Folder]\tester” directory when
using the Strategy Tester. To use a particular set-file for trading or testing, open ForexGridMaster on a chart and
then “Load” the preset file from the “Inputs” tab. ForexGM preset files can also be saved and shared with others. It
can be useful to name preset files to identify key elements of the strategies to which they relate.

As an example, a set-file could be named “audnzd_bsct5-s0.05 Isp0.015-ip16.2_tp21_m990-3_crppbts0.3-
ts0.0001_ce25-us100k.set”. This file would refer to a Buy-Sell Counter-Trend strategy for trading the AUDNZD pair
with Main Grid Spacing = 5 pips, Main Grid Spacing Step = 0.05 pips, Main Lot-Size(Proportional) = 0.015,
Main Lot-Size Increase Percent = 16.2, Main Take-Profit Pips = 21, CR Profit Percent Before TS = 0.3 with CR
Trail-Stop Percent = 0.0001 and works best trading at least $25,000 Chart-Equity of US $100,000 Account-
Currency. This might seem quite long-winded, but for a large number of strategies, it could be worth the effort.

Sharing Strategies:

Preset “.set” files can be shared directly with other traders, or online using the FOROQO system. Our hope is to
have many traders creating, back-testing and optimizing reliable winning strategies for all to share.

Back-Testing:

For back-testing ForexGM, use the M1 time-frame (Tick-data) to obtain the most accurate and reproducible
results. In the Tools > History Center menu, select Currency-Pair > 1 Minute (M1) and click “Download” to load the
data from MetaQuotes into the terminal. Trading a real-money account without having done any back-testing is
certainly not recommended. However, be aware that the history-data downloads for some currency-pairs from
MetaQuotes are not always accurate and complete.

The MetaTrader 4 Strategy Tester is known for its peculiarities, not the least of which is the way it interprets
Spread values. Theoretically, Spread is specified in “Points”, which should refer to the least-significant digit in the
quoted price. Some brokers offer trading in crypto-currencies, and this can result in very high Point values for
Spread causing the Tester to behave unpredictably. Best method to check if a chosen Spread is realistic is to set
both Bid and Ask lines visible on the test chart, and compare those with the Bid-Ask lines shown on an active chart.
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ForexGridMaster Input Settings Summary

These trader input settings listed here are linked to their detailed descriptions below. The value shown for each
setting corresponds to the default setting in ForexGM at the time of writing. The AUDNZD default strategy is for
demonstration purposes only, but can be traded as is on the AUDNZD and also the NZDCAD and AUDCAD with
minor adjustments. When correctly installed, ForexGM Advanced EA robot will show in the Experts folder on the
Navigator panel, which is normally displayed on the left side of the MetaTrader4 terminal. Drag and drop the robot
on the chart with the currency-pair you want to trade, and the Properties panel will open allowing modification of any
of the settings listed below. When set as desired, click the OK button and the ForexGM strategy will start trading
Run 1 on arrival of the next tick from the broker's server.

GENERAL CHART SETTINGS

EA Number

Strategy File

Strategy Info
Chart Equity Percent

Main Grid
Hedge Grid

MAINGRID GENERAL INPUTS

Main Order Type

Main Trend Direction

Main Grid Spacing

Main Max Pending Buy Orders
Main Max Pending Sell Orders
Main Max Open Buy Trades
Main Max Open Sell Trades

Main Center-Zone Pips
Main Grid Order Replacement

Main Open At Current Price
Main Hedging Option

MAINGRID ORDER INPUTS

Main Lot-Size

Main Lot-Size Scaling

Main Take-Profit Pips

Main Stop-Loss Pips

Main Break-Even Stop (BES)
Main Profit Pips Before BES

Main Break-Even Stop Plus Pips
Main Trail-Stop Pips (TS)

Main Profit Pips Before TS
Main Take-Profit Percent

Main Stop-Loss Percent

Main Trail-Stop Percent (TSP)
Main Profit Percent Before TSP
Main Take-Profit Money

Main Stop-Loss Money

Main Trail-Stop Money (TSM)
Main Profit Money Before TSM

65282

a6_audnzd_bsct5-s0.05 Isp0.015-ip16.2_tp21
m990-3_crppbts0.3-ts0.0001_ce25-us100k

100

( Disabled; Fixed-Center; Moving-Center )
( Disabled; Fixed-Center; Moving-Center )

( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half )
( Trend; Counter-Trend )

5

1

1

60

60

0

true

( Not-Used; Buy-Order; Sell-Order )

( Hedging-Option-Off; Pause-Main-On-Hedge; Close-Main-On_Hedge )

0.015

( LotSize-Constant; LotSize-Proportional )

21
0
false

MAINGRID FIXED-CENTER INPUTS

Main Grid-Spacing Step
Main Grid-Increment Percent

Main Lot-Size Increase Amount
Main Lot-Size Increase Percent
Main Lot-Size Increase Fibonacci
Main Take-Profit Pips Step

0.05
0.0
0.0
16.2
false
0.2
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HEDGEGRID GENERAL INPUTS

Hedge Order Type
Hedge Trend Direction
Hedge Grid Spacing

Hedge Max Pending Buy Orders
Hedge Max Pending Sell Orders

Hedge Max Open Buy Trades
Hedge Max Open Sell Trades
Hedge Center-Zone Pips

Hedge Grid Order Replacement

HEDGEGRID ORDER INPUTS

Hedge Lot-Size

Hedge Lot-Size Scaling
Hedge Take-Profit Pips

Hedge Stop-Loss Pips

Hedge Break-Even Stop (BES)

Hedge Profit Pips Before BES

Hedge Break-Even Stop Plus Pips

Hedge Trail-Stop Pips (HTS)
Hedge Profit Pips Before HTS

( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half )
( Trend; Counter-Trend )

6
1
1
6

6
360
true

3.0
( LotSize-Constant; LotSize-Proportional )

0
0
0

HEDGEGRID FIXED-CENTER INPUTS

Hedge Grid-Spacing Step

Hedge Lot-Size Increase Percent

GRID MOVING-CENTER INPUTS

Moving-Center Buy-Sell Overlap
Moving-Center Buy-Sell Offset Pips

TIME AND DAY INPUTS

Grid Start Time
Grid Stop Time
Trade Monday
Trade Tuesday
Trade Wednesday
Trade Thursday
Trade Friday

Trade Sunday
Close For Sunday-Friday Time

Friday Close Time
Friday Close Profit Only
Friday Close Time Period

MISCELLANEOUS INPUTS

Lot-Size Normalized
Show Comments
Log Activity

Log Debug Info

SPIKE CONTROL INPUTS
Spike Option
Spike Hedge Option

Spike Interval Seconds

Spike Pips per Interval
Spike Trades per Interval
Spike Pause Retrace Pips

0.1
6.0

false

ignore
ignore
true
true
true
true
true
true
ignore
ignore
true
120

true
true
true
false

( Spike-Main-Off; Pause-While-Active; Pause-Until-Reset;
Pause-Until-Retrace; Close-Main, Close-Run )

( Spike-Hedge-Off; Open-Hedge-On-Spike;
Open-Hedge-On-Spike-Up; Open-Hedge-On-Spike-Down )

990

0

3

0

©2018 Forex Grid Master — ForexGridMaster.com All rights reserved

Page 5 of 35


https://forexgridmaster.com/

AUTO-RESTART OPTIONS

Auto Restart After Profit ( Restart-Enabled; Restart-Disabled; After-Pips-Movement; After-Pips-Retrace )
Restart Seconds 0
Restart Pips Up or Down 20
Restart Pips Retrace 10

Auto Restart After Loss ( Restart-Enabled; Restart-Disabled; After-Pips-Movement; After-Pips-Retrace )
Restart Seconds 0
Restart Pips Up or Down 20
Restart Pips Retrace 10

CLOSE-RUN OPTIONS

CR Include Closed Trades Net true
CR Total Profit Percent 0.0
CR Total Loss Percent 70.0
CR Trail-Stop Percent (TSP) 0.0001
CR Profit Percent Before TSP 0.3
CR Loss Money 0.0
CR Trail-Stop Money (TSM) 0.0
CR Profit Money Before TSM 0.0
CR Profit Pips 0
CR Loss Pips 0
CR Trail-Stop Pips 0
CR Hedge Profit Percent 0.0
CR Hedge Loss Percent 70.0
CR Price Maximum 0.0
CR Price Minimum 0.0

IMMEDIATE-CLOSE OPTIONS

Close Greater-Profit-Than 0
Close Greater-Loss-Than 0
( Main-and-Hedge; Main-Grid-Only; Hedge-Grid-Only )
( Buys-and-Sells; Buys-Only; Sells-Only )
( Close-None; Delete-Pending; Close-Trades;
Close-At-Specified-Profit-Loss; Close-Run-Now )

Close Grid-Type

Close Orders-Type
Close Orders Now

Important - Some of the above settings can be changed on-the-fly. This means that if the EA properties-panel is
opened while ForexGM is active, specific input settings can be modified without the need to remove the EA and
reapply it to a chart. Settings that can be changed on-the-fly are generally those that will not change the basic
trading strategy.

Important - There are more options in the ForexGM_Advanced.prf file to control various aspects of ForexGM — the
information displayed on the chart; setting of Alerts; Aesthetics and more. A separate instance of this file is located in the
Tester/File folder that applies to Strategy Tester runs. Note that the settings in this file apply to all instances of ForexGM
that are installed on the various charts in the MT4 terminal.

Important - Be sure to back-test and walk-forward-test your strategies extensively in Strategy Tester for a year or more
to fully appreciate the functionality of the settings and their combined effects. Trade with a demo-account before you
trade a real money account. Please do not underestimate how important these steps really are. Be the master of your
destiny. “Risk comes from not knowing what you are doing.” -- Warren Buffet.
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ForexGridMaster Input Settings Detail

ForexGM Advanced trades two types of grids, a Main-Grid and a Hedge-Grid (or second grid). Main-Grid and
Hedge-Grid settings are mostly independent, except that Close-Runs are triggered by the net profit and loss
calculations of both Main-Grid and Hedge-Grid trades combined. In addition, there are a few settings that connect
the Main and Hedge grids, e.g. Main Hedging Option. Please note that the Hedge-Grid system is really a second
grid system that doesn’t have to be used for hedging, meaning that two grids can be traded on the same chart with
each grid having its own unique characteristics. As a simple example, two grids could have the same settings
except for different take-profit values — Hedge Take-Profit Pips = 15 and Main Take-Profit Pips = 21 could cover
price action more effectively than a single grid strategy.

The values of settings listed below are those built in as the default for ForexGM Advanced at the time of writing.
This Buy-Sell Counter-Trend strategy was tuned at some stage to be suitable for trading the AUDNZD pair. With a
slight adjustment to the settings, it may work for other currency-pairs that have similar price action. In any case, the
default strategy is for demonstration purposes only. Back-test and walk-forward test all ForexGM strategies over at
least a 3 year historical period to gain a thorough understanding of how the strategy works and what the risks are
before trading real money.

A few videos have been uploaded to the ForexGridMaster YouTube Channel to illustrate ForexGM in action.
There is a demonstration of a back-test for a previous strategy that ran live YTD until August 30, 2014, with an
explanation of the methodology as it trades. Also included is a video which goes into detail about the Spike
Protection mechanism. Some of these videos may refer to previous versions of ForexGM, but we plan to provide
updates in the near future.

We strongly recommend following the processes illustrated in the videos — it should help when customizing the
strategies for a particular trading style, risk-tolerance, and goals. You may also want to activate the Hedge-Grid
settings to hedge the Main-Grid, or use it as a second grid trading on the same chart. Portfolio trading can be set
up by trading a second instance (or more) of ForexGM on a second chart (or more) and dividing Account deposit
into sub-accounts using the Chart Equity Percent setting.

EA Number:

This input enables each instance of ForexGridMaster Advanced (ForexGM) to independently keep track of its
own trades and calculations without influence from other instances of ForexGM, other EAs, or any manual trades.
The EA Number should be unique for every EA instance running on the terminal, and because only one EA can be
attached to a chart, the EA Number also uniquely identifies a chart. ForexGM'’s input settings affect only orders
associated with the EA Number of the particular ForexGM instance. The EA Number can have any numeric value
up to a maximum of 9 digits, as long as there is no conflict with other EAs.

ForexGM has several mechanisms to help prevent duplicate EA numbers — before accepting any modification to
the settings, a check is made to see if there are other ForexGM instances already running with the chosen number.
Any attempt to change an EA Number assigned to chart by a previous run of ForexGM will be rejected, thus
helping to prevent unintentional loading of unrelated set-files. Global Variables are used to store persistent data
related to each ForexGM instance, and it is recommended that ForexGM EAs and possibly their related charts are
removed when no longer required. This setting cannot be changed on-the-fly.

Strategy File [ STF ]:

This field can contain any text up to a maximum of 64 characters. Text entered here will be displayed in the top
line of the comments at the top right of a chart. You can type anything here, but a meaningful description can help
when screen-shots are archived for future study. Text might relate to the set-file name and also contain some
reference to the parameters driving the strategy. This setting can be changed on-the-fly.

Strategy Info [ STI ]:

As with the Strategy File setting above, any text can be entered, and it will be displayed on the second line of
the chart comments. It might be useful to include additional details describing the particular strategy. This setting
can be changed on-the-fly.

Chart Equity Percent [ CEP ]:

ForexGM instances can trade with a specific Chart Equity, which can be any amount from 0 to 100% of Account
Equity. At the start of each run, Chart Equity is calculated from the current Account Equity and the CEP value.
When set to the default 100%, all funds in the trading account are available to ForexGM for trading. Please note
that this differs from the way Chart Equity was handled in previous versions where Chart Equity was set to a
specific monetary value. CEP provides a simple mechanism to control money-management. Because Chart Equity
is only determined at the start of a run, it can be changed on-the-fly to take effect when the next run commences.
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Main Grid: ( Disabled; Fixed-Center; Moving-Center)

When trading a Fixed-Center strategy, the center-line for the grid will be the current market Bid price when
ForexGM starts each Run. However if Main Open At Current Price is enabled for either a Buy or a Sell, then the
center-line will be half the Main Grid Spacing pips value away from the price that the Buy or Sell trade opened, and
exactly between the first Buy or Sell slots of the Grid. For Fixed-Center, the grid center-line will remain at the same
price for the duration of the Run and the rest of the grid will be based on that price. There are six settings
specifically related to Fixed grids — MainGrid Fixed-Center Inputs The Grid Type cannot be changed on-the-fly.

Trading a Fixed-Center strategy, the Buy and Sell pending orders are kept separated from each other, Buys on
one side of center-line price and Sells on the other, with no overlap allowed. As an example, when ForexGM
Advanced trades a Buy-Sell Trend strategy, only pending Buy Stop orders can be placed above the center-line
price and only pending Sell Stop orders can be placed below. If ForexGM was trading a Buy Trend Half-Grid, then
only pending Buy Stop orders would be placed above the grid center-line. For a Buy Counter-Trend Half-Grid
strategy, only pending Buy Limit orders are placed below the center-line.

A Moving-Center will change to always be the current moving market Bid price when you trade either a Buy or a
Sell grid, or a Buy-Sell grid combined with Buy-Sell Overlap = true and Buy-Sell Offset = true. However, when
trading a Buy-Sell grid with Buy-Sell Overlap = false, the Moving-Center option will place the center-line between
the Buy and Sell orders, and will continue moving to maintain that relative position. Buy and Sell pending orders
will be placed as close as possible to the moving center-line price according to the Grid-Spacing and the Center-
Zone Pips settings. See the section illustrating how this works -- FixedCenter and MovingCenter Scenarios.

Some brokers do not allow pending orders to be placed within 5 - 20 pips (more or less) of market price, and so,
depending on the Grid-Spacing, the initial grid position slots adjacent to grid center may not be filled with pending
orders until the current price has moved away far enough to allow it. In the meantime, grid slots further away from
the grid center-line are filled where possible according to the already established initial center-line price and other
input parameters.

Hedge Grid: ( Disabled; Fixed-Center; Moving-Center )

Disabled is the default where the Hedge-Grid is not activated, and all related hedge settings are ignored. A
Fixed-Center or Moving-Center Hedge Grid can be created to either hedge an active Main-Grid or trade a second
grid in parallel. The Hedge-Grid can also be traded on its own, the advantage being that for a Fixed-Center
Hedge-Grid, the Hedge Max Open Buy Trades and Hedge Max Open Sell Trades can be set to zero and the
number of grid slots is limited internally to 100, double the number permitted for the main grid. In most other
respects, Main and Hedge grids operate in much the same way. This setting cannot be changed on-the-fly.

Note that Main-Grid and Hedge-Grid cannot both be disabled or no trading would take place. If the Spike Hedge
Option is set to open the Hedge-Grid on a spike, the Hedge-Grid must be either Fixed-Center or Moving-Center.

©2018 Forex Grid Master — ForexGridMaster.com All rights reserved Page 8 of 35


https://forexgridmaster.com/

MAIN GRID GENERAL INPUTS

These settings are used to create the structure of the Main Grid.

Main Order Type [ MOT ]: ( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half )

This input determines whether the trade orders placed by ForexGM Advanced are either All Buy orders, All Sell
orders, or Both Buy and Sell orders, and also whether they are Half-Grid or Full-Grid. As an example, if the default
Buy-Sell is selected to trade a Trend grid to capture profit in the direction of the price trend, then Buy Stop orders
will be placed above grid center and Sell Stop orders below. If Buy-Sell is chosen with the Counter-Trend option,
then Buy Limit orders will be placed below grid center and Sell Limit orders above. This setting cannot be changed
on-the-fly.

Orders will be placed symmetrically on both sides of grid center when set to Buy-Full or Sell-Full, or one side
only when set to Buy-Half or Sell-Half. Buy-Sell grids automatically trade two half-grids, with one half Buy orders
and the other half Sell orders. This setting cannot be changed on-the-fly.

Here are some basic examples ...

@ You might wish to trade a Buy Trend grid to profit on price that is trending upwards. Choosing full-grid will
place pending Buy Stop orders above the center-line price and pending Buy Limit orders below for either a
Moving-Center or Fixed-Center strategy. For a half-grid, pending Buy Stop orders will be placed above
the center-line price, but no Buy Limits below. Using half-grids when trend-trading in only one direction will
reduce the number of open negative trades that accumulate over long price runs or spikes in the opposite
direction of the trend. Depending on the Grid-Spacing and the strength of the market trend, you might be
able to reduce the number of losing trades caused by retracements which open Buy Stops that follow the
price downwards.

Q@ If the price is expected to initially drop and then turn up shortly afterwards, an appropriate strategy would
use a Buy, Counter-Trend, Half-Grid. This would place a half-grid of pending Buy Limit orders below the
center-line, but no Buy Stops above.

@ For a price that stays within a relatively well defined range, a strategy set for Buy-Sell and Counter-Trend
should work well. The Buy-Sell strategy trades two half-grids, placing pending Sell Limit orders above the
center-line, and pending Buy Limit orders below.

Main Trend Direction [ MTD ]: ( Trend; Counter-Trend )

This input determines whether the grid is for a Trend or a Counter-Trend strategy. If Main Order Type is set to
either Buy-Full or Sell-Full, the option is ignored. A Trend grid places Buy Stops above grid center (Buy Trend), or
Sell Stops below grid center (Sell Trend) or both (Buy-Sell Trend). A Counter-Trend strategy places Buy Limits
below grid center (Buy Counter-Trend), or Sell Limits above grid center (Sell Counter-Trend) or both (Buy-Sell
Counter-Trend). If Main Center-Zone Pips is set non-zero, the top and bottom levels of the center-zone will be
used instead of the grid center. This setting cannot be changed on-the-fly.

Main Grid Spacing [ MGS ]:

This input sets the distance in pips between each pending order grid-slot and the next grid-slot for orders of the
same type (Buys or Sells). If the Main Center-Zone Pips setting is used, the first pending orders are placed at the
edge of the zone, and Grid-Spacing applies from there. This setting cannot be changed on-the-fly.

Main Max Pending Buy Orders [ MMPBO I:

This input determines both the number of pending Buy Limit or Buy Stop orders that the strategy will place at
grid start, and the maximum number of pending Buy orders permitted at any one time. If either or both Main Max
Open Buy Trades and Main Max Open Sell Trades are set to be greater than the default 1, then their values are
used to determine the limit of open trade slots allowed, and the number of pending orders will be controlled
accordingly. This means you cannot set MMPBO to a higher value than set for Max Open Buy Trades. If the
number of open Buy or Sell trades reaches the limit but then decreases (one or more open trades are closed), then
ForexGM will resume opening pending orders as dictated by the other strategy settings. ForexGM also limits the
total number of open pending orders to a maximum of 100. However, be aware that some brokers may not allow
that many open trades. This setting can be changed on-the-fly to a higher value but not lower.

Main Max Pending Sell Orders [ MMPSO ]:
This operates exactly like Main Max Pending Buy Orders above, but applies to pending Sell orders.
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Main Max Open Buy Trades [ MMOBT ]:

When set to the default 0, then no Buy trades can be opened. Any other numeric value sets a limit on the
maximum number of open Buy trades that ForexGM allows at any one time. Manual trades or other EAs with their
own unique EA Number can operate on the same account without influence from this setting. Many brokers limit
the total number of open orders in an account, but some do not -- check with your broker if you plan on heavy
trading. This setting can only be changed on-the-fly when Main-Grid is set for Moving-Center. In this situation, for
example with Main Max Open Buy Trades = 20, the total number of grid Buy slots (positions) that can be occupied
by Buy orders on the Buy side of the grid is fixed at 20. Trade orders occupying any of those 20 positions can be
opened, closed and replaced within a Run according to values set for other ForexGM inputs.

Main Max Open Sell Trades [ MMOST ]:
This operates exactly the same as Main Max Open Buy Trades above, but applies to Sell orders.

Main Center-Zone Pips [ MCZP ]:

When set to the default 0, this input is ignored. For a Moving-Center or Fixed-Center grid with Center-Zone
Pips set to a number greater than 0, the Buy and Sell orders will be separated by at least the specified number of
pips. For example, if Center-Zone Pips = 30, then no grid orders (pending or open) can occupy a slot inside that
30 pip zone. If a Moving-Center strategy is deployed, then the center-zone can move as the position of the Buys
and Sells move. However, no grid orders (open or pending) can occupy a position within the MCZP. When trading
a Half-Grid, say a Buy Trend strategy, then the exclusion zone extends to half the MCZP value from the grid center-
line. This setting cannot be changed on-the-fly.

When trading a Moving-Center strategy, MCZP moves in the direction of price and closing orders -- if orders
are closed within the current Run, the center-zone will be adjusted to maintain the separation between the Buy and
Sell orders. For a Moving-Center grid on a Buy-Sell strategy with Main Buy-Sell Overlap set to true, MCZP must
be disabled to allow overlaps to occur. However, when trading a Fixed-Center strategy, the center-zone will
remain fixed in place for the duration of the Run, keeping Buys and Sells separated by the value set. There are a
few examples of Main Center-Zone Pips for both Fixed-Center and Moving-Center grids in a later section —

FixedCenter and MovingCenter Scenarios.

Main Grid Order Replacement [ MGOR ]:

If set to true, when a Grid order has closed it will be replaced if the price returns to that same grid slot within the
same Run. If false, then each order within a Run will only be activated once for any given grid position. This setting
can be changed on-the-fly.

Main Open At Current Price [ MOCP ]: ( Not-Used; Buy-Order; Sell-Order )

When set to Not-Used, this setting is ignored. Set to either Buy-Order or Sell-Order, an order is opened
immediately at current price at the start of each Run. All other pending grid orders placed during the Run are
adjusted to that price position. In other words, the immediately opened trade is part of the grid being traded, and
therefore determines where the Grid-Spacing is anchored. For example, if Main Center-Zone Pips = 20 and a
Buy is opened at 1.3000 for a Buy-Sell Trend strategy, then the center-zone is from 1.3000 to 1.2980 and the grid
is structured around that price, the first pending Sell order slot being set at 1.2980.

Main Hedging Option [ MHO ]: ( Hedging-Option-Off; Pause-Main-On-Hedge; Close-Main-On-Hedge )

Hedging is normally used to counter the negative effects of a long loss-making stretch in the main grid. It can be
triggered to start trading after the main grid has reached some threshold. If hedging is set for a delayed start, for
example with a wide Main Center-Zone Pips on a Fixed-Center grid, the MHO can be used to specify what
happens to the Main-Grid when the first hedge trade is opened. The options available are to Pause or Close the
Main-Grid, or just continue trading the Main-Grid as before. Note that it is probably unproductive to control the
Main-Grid this way if the Hedge grid is configured to start trading almost immediately. This setting can be changed
on-the-fly, but care should be taken if opting for Close-Main-On-Hedge if a Hedge-Grid is already active.
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MAIN GRID ORDER INPUTS

These settings apply to all individual orders for both Fixed-Center and Moving-Center scenarios in the main grid.
Some extra settings which apply specifically to Fixed-Center or Moving-Center are covered in following sections.

Main Lot-Size [ MLS ]:

This input sets the base lot-size for individual Buy and Sell orders placed within a particular Run. Most brokers
allow a minimum lot-size of 0.01 which is 1/100th of the standard $100,000 lot-size, or $1,000 (using USD as
example) and for ForexGM, 0.01, a micro lot, is the minimum lot-size that can be set. Some brokers require
minimum lot-sizes 10 times higher to 0.10 ($10,000, a mini lot) in which case ForexGM will display a message that
the value needs to be within broker limits before trading can continue. Brokers sometimes provide Mini Accounts
with minimum lot-size of 0.01 which is 1/100th of the Mini Account lot-size of $10,000, or $100 in trade, a Nano lot.
Brokers sometimes offer the option to trade Micro-Accounts with a minimum lot-size of 0.01 which is 1/100th of the
Micro Account lot size of $1,000, or $10 in trade, a pico lot.

For Fixed-Center grids, the actual lot-size for individual orders within a Run can be controlled by Main Lot-
Size Increase Amount, Main Lot-Size Increase Percent, or Main Lot-Size Increase Fibonacci. This setting
cannot be changed on-the-fly for Fixed-Center grids. However, it can be changed for Moving-Center grids, but it
will only affect new pending orders and not pending orders already placed.

Main Lot-Size Scaling [ MLSS ]: ( LotSize-Constant; LotSize-Proportional )

The base lot-size for trade orders can remain constant for all Runs, or can change from Run to Run depending
on the Main Lot-Size Scaling setting, either LotSize-Constant or LotSize-Proportional. Main Lot-Size Scaling
cannot be changed on-the-fly.

If LotSize-Constant is selected, the base lot-size at the beginning of each Run is reset to Main Lot-Size [MLS].
When set to the default LotSize-Proportional, lot-size is set to MLS for the very first Run. On all subsequent Runs,
the base lot-size is set at the start of each Run to be MLS increased or decreased by the ratio of Current-Chart-
Equity to Original-Chart-Equity. However, if the calculated value is less than the MLS value set above, the lot-size
will be set to MLS for each new pending order placed until the new calculations result in a lot-size larger than MLS.
An exception to this rule could occur for Main_Grid Fixed_Center where lot-sizes are predefined for the slots and
there might be a dip in equity causing a new lot-size calculation lower than MLS. The absolute minimum value for
lot-size for any order is set by the broker, and ForexGM will apply this restriction if necessary.

LotSize Proportional can allow profits to compound when the equity curve is following an upward trend. On the
other hand, it can also reduce losses for a less-positive equity trend. As an example, suppose account-equity starts
Run 1 at $10,000 with Lot-Size = 0.10; LotSize-Proportional, CR_ProfitPercent = 10; and CR_LossPercent =
30. If the Close-Run is positive and reaches its equity increase profit target of 10% net of all open and closed
trades within the Run (CR Include Closed Trades Net = true), then start equity for Run 2 will be $11,000, and Lot-
Size will automatically be increased to 0.11. If the Close-Run was negative and the equity reduced 30% to $7,000,
the Lot-Size for Run 2 would be decreased to 0.07.

Main Take-Profit Pips [ MTPP ]:

This input determines how many pips profit each of the individual trade orders will target. For example, you
might be trading the EURUSD, and a pending Buy order is open at 1.3700 with Main Take-Profit Pips = 35. If the
price reaches 1.3735, the trade will be closed by the broker capturing 35 pips profit (ignoring slippage). When set
to 0, this input is ignored. For Moving-Center grid only, this setting can be changed on-the-fly, although it will only
affect new pending orders and not pending orders already in place.

Main Stop-Loss Pips [ MSLP ]:

This determines the Stop Loss for each individual trade order. If set to the default 0, this input will be ignored. If
for example you are trading the EURUSD and a trade order opens at 1.3700 with Stop-Loss Pips = 50, and if the
price then drops to 1.3650, the trade will be triggered to close at a loss of 50 pips. This setting can be changed on-
the-fly when trading a Moving-Center grid, and will affect new pending orders only, not pending orders already in
place.

Main Break-Even Stop [ MBES ]:

When set to true, a break-even Stop-Loss will be set for each order according to the rules dictated by the
additional settings Main Profit Pips Before Break-Even Stop and Main Break-Even Stop Plus Pips. Set to
false, MBES is disabled and the associated settings are ignored. These settings can work in conjunction with Main
Profit Pips Before Trail-Stop Pips described below. These settings cannot be changed on-the-fly.

Main Profit Pips Before Break-Even Stop [ PPBBE ]:

When MBES = true, this setting is enabled. If set to 10 as an example for an open pending order, and the price
moves 10 pips into profit, a break-even stop is placed on the order so that a price retrace will close the order at
break-even plus the value of the following BESPP parameter. This value can only be set to whole pips, not
fractional pips.
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Main Break-Even Stop Plus Pips [ BESPP ]:

The value in pips set here adds to the break-even stop. For example, if BESPP is set to 3 pips and PPBBE = 10
pips, it means that when an open order reaches its 10 pip profit target and MBES is triggered, a price retrace of 7
pips (10 — 3) will cause the order to close 3 pips in profit. This setting is useful to offset commission, swap fees or
slippage.

Main Trail-Stop Pips [ MTSP ]:

This input determines the number of pips the trail-stop should be placed away from the open price. As an
example, if MTSP = 50 and MPPBTS = 0, then a stop-loss is immediately set at 50 pips away from the pending
order open price. That stop-loss will then trail pip by pip as the price moves in a profitable direction. If price moves
in a losing direction then the trailing stop-loss will remain stationary and close the order when the stop-loss price is
reached. Another example -- if MTSP = 9 and MPPBTS = 36, when each individual order is 36 pips into profit, the
trail-stop of 9 is triggered and 27 pips of profit will be locked in. If the price keeps moving in a profitable direction,
the trail-stop will follow pip by pip. Let’s say that an individual order moves 50 pips into profit and then retraces 9
pips. The trade would then close out with 41 pips profit.

Main Profit Pips Before Trail-Stop Pips [ MPPBTS ]:

If set to the default O pips, this setting is ignored. Set to a value such as 36 as an example, each of the
individual orders that are opened will need to move 36 pips into profit before Main Trail-Stop Pips is activated. If
MPPBTS = 0 then MTSP will determine the initial trailing stop-loss. This functions differently to Stop-Loss Pips
which fixes the Stop-Loss on the broker's server. This setting cannot be changed on-the-fly.

Main Take-Profit Percent [ MTPPC ]:

If set to the default 0, this setting is ignored. For a non-zero value, the order will close when profit for the
particular order reaches this percentage of the current chart-equity. As an example, if MTPPC = 1.5, 1.5% of chart-
equity is the profit target for the order.

Please note an important difference here — Main Take-Profit Pips is a target registered on the broker's
server, whereas Main Take-Profit Percent is controlled by ForexGM in stealth-mode and is not visible to the
broker.

Main Stop-Loss Percent [ MSLPC ]:

If set to the default O, this setting is ignored. For a non-zero value, the order will close when loss related to the
particular order reaches this percentage of the current chart-equity. As an example, MSLPC = 1.0 would cause the
order to close when the money-amount loss equals 1.0% of chart-equity. This stealth-mode setting can be changed
on-the-fly.

Main Trail-Stop Percent [ MTSPC ]:

This setting is similar to Main Trail-Stop Pips, but both settings cannot be active at the same time. It defines the
trail-stop in terms of Chart-Equity percentage, and can be used in conjunction with the Main Profit Percent Before
Trail-Stop Percent setting. As an example, if MPBTPC = 0.35 and MTSPC = 0.05, then the stop-loss money value
would be equal to 0.05% of the current chart-equity. That money stop-loss determined by 0.05% percent of equity
will then trail if the price moves in a profitable direction. If the price moves in a losing direction, the trailing percent
stop-loss will remain fixed and close the order when the target is reached. Now if MPBTPC = 0.55 and MTSPC =
0.05, then when each individual order has attained an amount of profit equal to 0.55% of current chart-equity, the
trail-stop is triggered and profit is locked in. If the price keeps moving in a profitable direction, the trail-stop will
follow by a value equal to 0.05% of the chart-equity. This stealth-mode setting cannot be changed on-the-fly.

Main Profit Percent Before Trail-Stop Percent [ MPBTPC ]:

If set to the default O percent, then this setting is ignored. For a non-zero value, such as 0.35 as an example,
then each of the individual open orders must be 0.35% of chart-equity into profit before the Main Trail-Stop
Percent is activated. If MPBTPC = 0, then MTSPC becomes active as soon as the order is opened. This percent
setting also operates in stealth-mode and cannot be changed on-the-fly.

Main Take-Profit Money [ MTPM ]:

This setting is similar to Main Take-Profit Percent except that the profit target is a fixed amount rather than a
percentage of chart-equity. If set to the default 0, this setting is ignored. For a non-zero value, the order will close
when profit for the particular order reaches the money amount specified. It is important to appreciate that this
quantity will not automatically scale with equity, and may need to be adjusted manually as equity changes. As an
example, if MTPM = 50, the order will close when profit reaches 50 units of account-currency. Main Take-Profit
Money is a target maintained within ForexGM and is not visible to the broker. It can be changed on-the-fly.
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Main Stop-Loss Money [ MSLM ]:

If set to the default O, this setting is ignored. For a non-zero value, the order will close when loss related to the
particular order reaches this amount in account-currency units. As an example, MSLM = 75 would cause the order
to close when the money-amount loss equals 75 units of account-currency. This stealth-mode setting can be
changed on-the-fly.

Main Trail-Stop Money [ MTSM ]:

This setting is similar to Main Trail-Stop Pips and Main Trail-Stop Percent, but these settings are mutually
exclusive and should not be used together. If Main Trail-Stop Percent and Main Trail-Stop Money are both
specified, MTSPC will take precedence. MTSM dictates the number of account-currency units used for the trail-
stop money value, and can be used in conjunction with the following MBTSM setting. As an example, if MTSM = 50
and MBTSM = 100, then the stop-loss money value would be equal to 50 units of account-currency. If price moves
in a profitable direction, the actual profit required to close the order on a retrace, is increased. If the price moves in
a losing direction, the trailing money threshold will remain constant and the order will close when the target is
reached. This stealth-mode setting cannot be changed on-the-fly.

Main Profit Money Before Trail-Stop Money [ MBTSM ]:

If set to the default O, this setting is ignored. For a non-zero value, such as 200 as an example, then each of the
individual open orders must reach a profit of 200 account-currency units before Main Trail-Stop Money is
activated. If MBTSM = 0, then MTSM becomes active as soon as the order is opened. This setting also operates in
stealth-mode and cannot be changed on-the-fly.

MAIN GRID FIXED-CENTER INPUTS

The following parameters modify grid orders when the Main-Grid = Fixed-Center, and are ignored for a Moving-
Center grid. All these settings depend upon the slot position where an order is initially placed. If Main Grid Order
Replacement is true, then any order replacing one that was closed earlier in the Run will have exactly the same
characteristics as the order it replaces.

Main Grid-Spacing Step [ MGSS ]:

When set to the default 0, this input is ignored. Set to a non-zero value, the space between grid-slots is
increased incrementally by that amount as the grid moves out from its center-line. The value can be either a whole
number or a decimal representing fractional pips. For example, if trading a Buy-Sell grid with Grid-Spacing = 10
and Grid-Spacing Step = 0.2, the separation between the first Buy and first Sell slot positions will be 10 pips. The
interval between the first and second Buy slots will be 10.2 pips, then 10.4 pips for the next, and so on. Same
formula applies to the Sell orders in the other half of the grid. Whenever a new Run commences, Grid-Spacing
Step starts to increment the spacing again from scratch. This setting cannot be changed on-the-fly.

Main Grid-Increment Percent [ MGIP ]:

MGIP works in a similar way to the MGSS setting above. The default of 0 means this setting is ignored. As an
example, suppose Grid-Spacing is set to 10 with MGIP = 10% for a Buy-Sell grid. Separation between center-
most slots will be 10 pips. Next slots will be spaced 11 pips apart, then 12.1, and so on. This setting should not be
changed on-the-fly.

Main Lot-Size Increase Amount [ MLIA ]:

Default for this setting is 0, which means the input is ignored. When non-zero and Main-Grid = Fixed-Center,
the base lot-size as determined by either LotSize-Constant or LotSize-Proportional, is increased incrementally
from one pending order slot to the next by that amount. For example, if the base lot-size for a grid is 0.15 and MLIA
= 0.01, then lot-size for the next pending order placed at slot #2 will be 0.16, the next one 0.17, next 0.18, and so
on. When a Run is closed (all open trades closed and pending orders deleted) and a new Run begins, the lot-sizes
are allocated as previously either by Lot-Size or Lot-Size Percent. This setting cannot be changed on-the-fly.

Main Lot-Size Increase Percent [ MLIP ]:

When set to the default 0, this input is ignored. When set to a percent and Main-Grid = Fixed-Center, the lot-
size as determined by either LotSize-Constant or LotSize-Proportional, is increased incrementally by that
percentage from one pending order slot to the next. This setting may be useful for Martingale strategies made
famous by professional gamblers. For example, if the starting pending order lot-size is say 1.20 and MLIP = 100%,
then the next pending order lot-size would be increased by 100% to 2.40, the next to 4.80, then 9.60, and so on.
For a starting lot-size of 1.20 and MLIP = 50%, the next pending order lot-size would be increased by 50% to 1.80,
followed by 2.70, 4.05, etc. As a new Run begins for a Fixed-Center grid, lot-sizes are again calculated using the
formula described above. This setting cannot be changed on-the-fly.
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Main Lot-Size Increase Fibonacci [ MLIF ]:

Default is false and this input is ignored. When set to a true and Main-Grid = Fixed-Center, the lot-size set by
either LotSize-Constant or LotSize-Proportional, is increased incrementally from one pending order slot to the
next in accordance with the Fibonacci series... 0, 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, etc. The series is based on the
formula “next number = current number + previous number”. For example, if the base lot-size is 1.2, then the next
lot-size will be 1.2 (1.2 + 0, the previous lot-size); next lot-size will be 2.4 (1.2 + 1.2), next 3.6 (2.4 + 1.2), then 6.0
(3.6 + 2.4), 9.6, and so on. When a fresh Run starts, these lot-sizes are again calculated using the formula with
whatever base lot-size applies at the time. This setting cannot be changed on-the-fly.

Main Take-Profit Pips Step [ MTPPS ]:

When set to the default 0, this input is ignored. For a non-zero value, Main Take-Profit Pips is incremented by
MTPPS from one pending order slot to the next. For example, if MTPP = 20, MTPPS = 0.5 and there are 6 Fixed-
Center slot Buy positions (created with Main Max Open Buy Trades = 6), then the order at Buy slot 1 (closest to
grid center) has Take-Profit Stop = 20; the Buy order at slot 2 position has Take-Profit Stop = 20.5; Buy 3 to Take-
Profit Stop = 21; Buy 4 Take-Profit Stop = 21.5; Buy 5 Take-Profit Stop = 22; and Buy 6 (furthest from grid center)
has Take-Profit Stop = 22.5. Not only can the lot-size be increased for grid orders moving out from grid center, but
their Take-Profit pips can increase as well — this might prove useful for Counter-Trend strategies stretched over a
large range where larger retracements are required. This setting cannot be changed on-the-fly.

HEDGE GRID GENERAL INPUTS

Hedge-Grids are controlled by settings that largely mirror those for Main-Grids. The logic behind having a
Hedge-Grid is to allow a rapid (and automatic) switch of strategy when a significant change in price trend is
identified. Main-Grids and Hedge-Grids can operate independently, although they work in conjunction when
controlled by the Close-Run mechanism.

As the name suggests, the primary purpose for the Hedge-Grid is to counter possible negative outcomes when
trading only the Main-Grid. However, they also allow a second strategy to trade simultaneously with the Main-Grid
strategy, both in the same ForexGM instance (i.e. both in the same Chart). By using Hedge-Grid settings that differ
slightly from those of the Main-Grid, an even higher level of control is available than for a single grid. An example of
a secondary grid might have Hedge Center-Zone Pips = 0 and Main Center-Zone Pips = 400, which would result
in a Hedge-Grid inside the grid created by Main-Grid settings.

Another example could have Fixed-Center Main and Hedge Grids with the Hedge-Grid set to trade in a Trend
direction, and configured to start once the price moves outside the 'comfort zone' of a Main-Grid trading a Counter-
Trend strategy. The threshold for the start of a Hedge-Grid is controlled by setting Hedge Center-Zone Pips. If the
Main and Hedge Grids are intended to work in conjunction with each other, Fixed-Center options would be
appropriate.

One subtle difference between Main and Hedge Grids is the way they can respond to a Spike event. Normal
usage for a Spike event in the Main-Grid is to either Pause or Close a Run once it has already commenced. For a
Hedge-Grid, there is also an option to delay the start of a Run until a Spike condition occurs. A delayed-start
Hedge can run quite independently, and does not require the Main-Grid to be enabled.

Hedge Order-Type [ HOT ]: ( Buy-Sell; Buy-Full; Sell-Full; Buy-Half; Sell-Half )

This input specifies that trade orders placed for Hedge-Grids are either All Buy Orders, All Sell Orders, or Both
Buy and Sell orders, and also if the grid is a Half-Grid or Full-Grid. Pending orders (Limit and Stop orders) will be
placed symmetrically on both sides of grid center when set to Full-Grid for Buy or Sell grids, or one side only when
set to Half-Grid for either Buy or Sell grids. Buy-Sell grids automatically trade two Half-Grids with a Half-Grid of
Buy orders plus a Half-Grid of Sell orders. As an example, if the default Buy-Sell is selected to trade a Trend grid
to capture profit in the direction of the price trend, then Buy Stop orders will be placed above grid center or at the
top of the Hedge Center-Zone Pips (if set), and Sell Stop orders below. If Buy-Sell is chosen with the Counter-
Trend option, then Buy Limit orders will be placed below grid center and Sell Limit orders above. Some basic
examples can be found in the Main section describing Order-Type — Main Order Type. This setting cannot be
changed on-the-fly.

Hedge Trend Direction [ HTD ]: ( Trend; Counter-Trend )

This input determines whether the Hedge-Grid will be for either a Trend or Counter-Trend strategy. If Hedge
Order Type is set to either Buy-Full or Sell-Full, the option is ignored. A Trend grid places Buy Stops above grid
center (Buy-Trend), or Sell Stops below grid center (Sell-Trend), or both (Buy-Sell Trend). A Counter-Trend
strategy places Buy Limits below grid center (Buy Counter-Trend), or Sell Limits above grid center (Sell Counter-
Trend) or both (Buy-Sell Counter-Trend). If Hedge Center-Zone Pips is set non-zero, the top and bottom levels of
the center-zone will be used instead of the grid center. This setting cannot be changed on-the-fly.
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Hedge Grid Spacing [ HGS ]:

This input sets the distance in pips between each hedge grid-slot and the next grid-slot for orders of the same
type (Buys or Sells). The Hedge-Grid and the Main-Grid share a common center-line. If the Hedge Center-Zone
Pips setting is used, the first pending orders are placed at the edge of the center-zone, and HGS applies outwards
from there. This setting cannot be changed on-the-fly.

Hedge Max Pending Buy Orders [ HMPB ]:

This input determines the number of pending Buy Limit or Buy Stop orders that the hedge strategy will place at
grid start, and the maximum number of pending Hedge Buy orders permitted at any one time. If either HMPB or
HMPS is set to be greater than the default 0, then HMOB and HMOS will limit the number of open trade slots, and
the number of pending orders will be controlled accordingly — this means HMPB cannot be set to a value higher
than HMOB. If the number of open Hedge Buy or Sell trades reaches the limit but then decreases (one or more
open trades are closed), then ForexGM will resume opening pending Hedge-Grid orders as dictated by the other
strategy settings. ForexGM also limits the total number of open pending orders to a maximum of 100. However, be
aware that some brokers may not allow that many open trades. This setting can be changed on-the-fly to a higher
value but not lower.

Hedge Max Pending Sell Orders [ HMPS ]:

This operates the same as Hedge Max Pending Buy Orders above, but is for Sell orders. It specifies the
number of pending Hedge Sell Limit or Sell Stop orders placed at grid start, and also the maximum number
permitted at any one time. If either HMPB or HMPS is set to be greater than the default 0, then HMOB and HMOS
will limit the number of open trade slots, and the number of pending orders will be controlled accordingly — this
means HMPS cannot be set to a value higher than HMOS. [f the number of open Hedge Buy or Sell trades reaches
the limit but then decreases (one or more open trades are closed), then ForexGM will resume opening pending
Hedge-Grid orders as dictated by the other strategy settings.

Hedge Max Open Buy Trades [ HMOB ]:
Hedge Max Open Sell Trades [ HMOS ]:

When set to the default 0, these inputs are ignored. When set to a number such as 3 for example, then the
maximum number of Hedge-Grid open Buy/Sell trades at any one time is limited to that number (3). These settings
operate differently from Main Max Open Buy Trades and Main Max Open Sell Trades which not only limit the
maximum number of Main-Grid open Buy/Sell trades at any one time, but also limit the number of Buy/Sell order
positions in a Main Fixed-Center grid that can be filled by Main-Grid orders. HMOB/HMOS will continue placing
Hedge-Grid orders as the price moves outwards further and further away from grid-center, but will also limit the
number of Hedge-Grid Buy/Sell orders allowed open at any one time, such as 3 in this example.

Hedge Center-Zone Pips [ HCZP ]:

If set to the default 0, this setting is ignored. For a whole pip value greater than 0, Hedge Center-Zone Pips
works almost the same way as does Main Center-Zone Pips. Hedge Center-Zone Pips is centered around the
Hedge center-line, which corresponds to the Main center-line at the start of the Run if Main-Grid is active. This
HCZP determines the minimum separation between the center-line and the innermost Hedge Buy and Sell orders.
For example, if HZCP = 100 then no Hedge orders can be placed within that 100 pip range. Main-Grid orders are
unaffected by this setting and can be placed inside that zone if desired. The initial Hedge-Grid orders are placed
immediately at the extremes of HCZP — the distance between the first Hedge-Grid order at the top of the zone and
the first Hedge-Grid order at the bottom is exactly 100 pips. When trading a Hedge Half-Grid, say a Buy Trend
strategy, then the spacing is half the value of HCZP. This setting cannot be changed on-the-fly.

Hedge Grid Order Replacement [ HGOR ]:

If HCZP is set to true then whenever a Hedge-Grid order closes, it will always be replaced when possible within
the same Run. If set to false then each Hedge-Grid order within a Run will only be placed once. This setting
operates independently from Main Grid Order Replacement.

HEDGE GRID ORDER INPUTS

Hedge Lot-Size [ HLS ]:

This input determines the base lot-size for the Hedge grid orders. If the next setting, Hedge Lot-Size Scaling,
is set to LotSize-Constant, the lot-size is set to HLS for all grid orders. By fixing a minimum HLS, ForexGM can
detect a potential margin-call situation, and take the appropriate action. Please note that the chosen HLS value
cannot be less than the minimum lot-size required by broker.

Hedge Lot-Size Scaling [ HLSS ]: ( LotSize-Constant; LotSize-Proportional )

If HLSS is set to the default LotSize-Proportional, the HLS value is used when initiating ForexGM for Run 1.
For all subsequent Runs, the base lot-size will be increased or decreased by the ratio of Start-Run Equity to Start-
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Run1 Equity. When set to LotSize-Constant, the lot-size at the beginning of each Run (and within the Run if
Fixed-Center Lot-Size Increase settings are not used) will remain the same from one Run to the next.

For example, say the account-equity starts at $10,000 for Run 1 with HLS = 0.10, Lot-Size Scaling = LotSize-
Proportional, CR-ProfitPercent = 10 and CR-LossPercent = 30. If the Close-Run is positive and reaches its
equity increase profit target of 10% net of all open and closed trades within the Run ( with default CR Include
Closed Trades Net = true), then Run 2 start equity will be $11,000, and the base lot-size will automatically be
increased to 0.11. If Run 1 closes when equity has reduced 30% to $7,000, then base lot-size is decreased to 0.07
for Run 2. Regardless of whether Hedge Lot-Size_Scaling is LotSize-Proportional or LotSize-Constant, the lot-
size can be automatically increased from slot to slot going out from the grid center-line within a Run by using the
Hedge Fixed-Center input, Hedge Lot-Size Increase Percent. HLSS cannot be changed on-the-fly.

Hedge Take-Profit Pips [ HTPP ]:

This input determines how many pips profit each of the pending hedge orders will target and capture. If for
example, the EURUSD is traded, and a pending Hedge-Grid Buy order is set to open at 1.3700 and it opens, and
Hedge Take-Profit Pips = 35, then when price reaches 1.3735, the trade will close capturing 35 pips of profit.
When set to 0, this input is ignored.

Hedge Stop-Loss Pips [ HSLP ]:

This determines the stop-loss for each individual Hedge-Grid order. If set to 0 then this input is ignored. If for
example, the EURUSD is being traded, and a Hedge-Grid Buy order is open at 1.3700, and Hedge Stop-Loss Pips
=50, and then the price drops to 1.3650 triggering the 50 pip stop loss, the trade will close at a loss of 50 pips. This
setting can be changed on-the-fly, although it will only affect new pending orders, not those already placed.

Hedge Break-Even Stop [ HBES ]:

When set to true then a break even stop-loss can be set on each individual Hedge-Grid order, which will be
triggered according to the values set by the next two settings, HPBBES and HBESPP.

Hedge Profit Pips Before Break-Even Stop [ HPBBES ]:

When HBES = true then this setting is enabled. As an example, if HPBBES is set to 10 and a pending order is
opened followed by a price-move 10 pips into profit, a break-even stop is placed on the order so that if the price
retraces 10 pips, the open trade is closed at its opening or break-even price (plus the value of the next setting,
HBESPP). This value can only be set to whole pips, not fractional pips. This setting cannot be changed on-the-fly.

Hedge Break-Even Stop Plus Pips [ HBESPP ]:

The value in pips set here adds to the break-even stop. If HBESPP is set to the default of 1 as an example, it
means that if HPBBES = 10 and an open order reaches 10 pips of profit to trigger the Hedge Break-Even Stop, a
price retrace of 9 pips (10 — 1) will close the order 1 pip in profit. This setting is useful to offset commission charges
or slippage.

Hedge Trail-Stop Pips [ HTSP ]:

This input determines how many pips the Hedge Trail-Stop will be. As an example, if HTSP = 50 and Hedge
Profit Pips Before Trail-Stop Pips = 0, then a stop-loss is immediately set 50 pips away from the price the order
opened. That stop-loss will then trail pip-by-pip behind the price if it moves in a profitable direction. If price moves
in a losing direction then the trailing stop-loss will remain fixed. Another example -- if HPPBTS is 36 and HTSP is
set to 9, then when each individual order is 36 pips into profit, the trail-stop of 9 is triggered and 27 pips of profit will
be locked in. Let’s say that an individual order moves 50 pips into profit and then retraces 9 pips, the trade will then
close out with 41 pips of profit. This setting cannot be changed on-the-fly.

Hedge Profit Pips Before Trail-Stop Pips [ HPPBTS ]:

This setting is used in conjunction with Hedge Trail-Stop Pips. It specifies the threshold of pips in profit to be
reached before a trail-stop becomes active. When set to the default 0 pips, the HTSP trail-stop comes into effect
immediately. For example, if HPPBTS = 36, each of the individual open hedge orders need to move 36 pips into
profit before the trail-stop is activated. It differs from Hedge Stop-Loss Pips which fixes the stop-loss at a given
price. This setting cannot be changed on-the-fly.

HEDGE GRID FIXED-CENTER INPUTS

Hedge Grid-Spacing Step [ HGSS ]:

When set to the default 0, all grid slots are spaced evenly apart. For a non-zero value, the space between
hedge-grid slots is increased incrementally by that amount as the grid moves out from its center-line. The value
can be either a whole number or a decimal representing fractional pips. For example, if trading a Buy-Sell grid with
Grid-Spacing = 10 and Grid-Spacing Step = 0.2, the separation between the first Buy and first Sell slot positions
will be 10 pips. The interval between the first and second Buy slots will be 10.2 pips, then 10.4 pips for the next,
and so on. Same formula applies to the Sell orders in the other half of the grid. Whenever a new Run commences,

©2018 Forex Grid Master — ForexGridMaster.com All rights reserved Page 16 of 35


https://forexgridmaster.com/

Hedge Grid-Spacing Step starts to increment the spacing again from scratch. This setting cannot be changed on-
the-fly.

Hedge Lot-Size Increase Percent [ HLSIP ]:

When set to the default 0, this input is ignored and all orders placed in the grid for the particular Run will have
the same lot-size. When set to a percent value and Hedge-Grid is Fixed-Center, then the lot-size as determined by
either Hedge LotSize-Constant or Hedge LotSize-Proportional, is increased incrementally from one Hedge-Grid
pending order to the next by that percentage. For example, if the starting Hedge-Grid pending order lot-size is say
1.2 and HLSIP = 100, then the next pending order lot-size would be increased by 100% to 2.4, the next one to 4.8,
the next to 9.6, and so on.

If starting with a lot-size of 1.2 and HLSIP = 50, then the next pending order lot-size would be increased by 50%
to 1.8, the next one to 2.7, then 4.05, and so on. When a Run is closed (all Main-Grid and Hedge-Grid open trades
closed and pending orders deleted) and a new Run begins automatically ( see Auto-Restart Options ), the Hedge-
Grid lot-sizes are again set according to HLSIP and the rules for lot-size scaling — Hedge Lot-Size Scaling. This
setting cannot be changed on-the-fly.

GRID MOVING-CENTER INPUTS

The following two settings apply to Moving-Center strategies for both Main-Grids and Hedge-Grids. They are
ignored for Fixed-Center grids.

Moving-Center Buy-Sell Overlap [ MCBSOV ]:

When set to true, grid Buy orders and Sell orders can overlap. Moving-Center Buy-Sell Overlap = false
ensures all pending or open Buy orders on one side of the grid will remain separated from all Sell orders on the
other side (see examples below). This setting cannot be changed on-the-fly.

Moving-Center Buy-Sell Offset Pips [ MCSOP ]:

This option prevents Buy and Sell orders from occupying the same price slot positions when trading a Buy-Sell
strategy involving Moving-Center Buy-Sell Overlap set to true. When set, it applies to both the Main-Grid and the
Hedge-Grid. If Buy and Sell orders are placed at the same price, it can be difficult to identify them by their graphical
representation on a chart. A slight offset can make them more distinguishable without greatly affecting trading
outcomes. MCSOP specifies how many pips Sell orders will be placed below Buy orders in a Buy-Sell grid where
Buys and Sells overlap. This does not affect Grid-Spacing or Center-Zone Pips for either type of grid. This setting
cannot be changed on-the-fly.

Here are a few examples using EURUSD prices...

Grid-Spacing = 6 Grid-Spacing = 6 Grid-Spacing = 3
Center-Zone Pips =0 Center-Zone Pips =0 Center-Zone Pips = 6
Buy-Sell Overlap = true Buy-Sell Overlap = true Buy-Sell Overlap = false
Buy-Sell Offset Pips = 3 Buy-Sell Offset Pips = 1 Buy-Sell Offset Pips = 0
------------- 1.37070 - 1.37070 - 1.37070
--- Buy --- 1.37060 --- Buy --- 1.37060 --- Buy ---  1.37060
------------- 1.37050 --- Sell ---  1.37050 - 1.37050
------------- 1.37040 - 1.37040 - 1.37040
---Sell --- 137030 | = - 1.37030 --- Buy --- 1.37030
------------- 1.37020 - 1.37020 ---- CZ---- 1.37020
------------- 1.37010 - 1.37010 ---- CZ---- 1.37010
--- Buy ---  1.37000 --- Buy --- 1.37000 ----CZ---- 1.37000
------------- 1.36990 --- Sell ---  1.36990 ---- CZ---- 1.36990
------------- 1.36980 --mmmem——- 1.36980 ---- CZ---- 1.36980
---Sell --- 136970 | = - 1.36970 --- Sell ---  1.36970
————————————— 1.36960 mmmmmemme= - 1.36960 —mmmmeem—- - 1.36960
------------- 1.36950 mmmmmmmemee= - 1.36950 mmmmemmem—- - 1.36950
--- Buy --- 1.36940 --- Buy --- 1.36940 --- Sell ---  1.36940
------------- 1.36930 --- Sell ---  1.36930 -—m-mmm——- - 1.36930

©2018 Forex Grid Master — ForexGridMaster.com All rights reserved Page 17 of 35


https://forexgridmaster.com/

TIME AND DAY INPUTS
These settings apply to both Main-Grids and Hedge-Grids.

Grid Start Time: ( default = “ignore” )

When set to the default “ignore”, this setting has no effect. This input determines the time of day when ForexGM
will open a grid of pending orders. It is the 24-hour time relative to Market Watch time which is displayed on the
title-bar of the Market Watch panel of the terminal when connected with a broker and the market is open. If Grid
Start Time = 00:01 as one example, then ForexGM is activated at 00:01 (midnight) Market Watch time. If set to
08:30, then ForexGM will start placing orders automatically at 8:30 am. If set to 20:30, then orders will be placed
from 8:30 pm onwards. Grid Start Time can work independently, or in conjunction with Grid Stop Time. If Grid
Start Time is set to any value and Grid Stop Time = “ignore”, all orders will be closed at midnight on the day they
opened, ready to start again the next day if required. This setting can be changed on-the-fly anytime before it has
been triggered.

Grid Stop Time: ( default = “ignore” )

When set to the default of “ignore”, this setting is ignored as one might expect. This input determines what time
ForexGM will stop the present Run and close out all open trades and delete all pending orders. The format is the
same as for Grid Start Time, and these two settings work in tandem to control the daily period for trading. For
example, if Grid Start Time is set to 23:00 and Grid Stop Time is set to 07:25, then ForexGridMaster will trade
through the night and shut down at 07:25 (7:25 am) in the morning to start a new Run at 23:00 (11:00 pm). This
cycle is repeated for all trading days that are enabled (all days are enabled by default). Another scenario might
have the time period set by Grid Start Time | Grid Stop Time as 08:05 to 19:35, which would result in active
trading from 8:05 am through the day until 7:35 pm. This setting can be changed on-the-fly anytime before it has
been triggered.

Trade Monday: ( default = true )
Trade Tuesday: ( default = true )
Trade Wednesday: ( default = true )
Trade Thursday: ( default = true)
Trade Friday: ( default = true)

When one or more of the Trade Day input settings are set to their default values of true, trading is enabled for
those particular days, week after week, continuously until these settings are changed. Trade Day settings are
based on Market Watch time which is displayed on the title-bar of the Market Watch window on the MetaTrader 4
terminal. The time period for each Trade Day starts at 00:00:00 Midnight and ends 24 hours later at 23:59:59.
Whenever one or more of the Trade Day settings are set to false, then trading is disabled for those days, and a
complete Close-Run is triggered at 00:00:00 on the specified days to close all open trades and delete all pending
orders. If CR Auto-Restart = true, a new Run will start automatically, but not until the next enabled Trade Day. If
CR Auto-Restart = false, the EA must be manually restarted. These Trade Day settings can be changed on-the-fly
anytime before their trigger time.

As an example, if Trade Monday is set to false, trading will be disabled for Mondays from 00:00:00 to 23:59:59
Market Watch time. If a Run is open and trading on the preceding Sunday, then that Run will close at 00:00:00
midnight Market Watch time between Sunday and Monday, and a new Run will not start up automatically until the
next enabled Trade Day. When Close-Run is triggered, all open trades and pending orders are closed.

Trade Sunday: ( default = true )

Sundays are handled differently from the other days because the market can sometimes be closed to reopen on
a Sunday. This is the case for most Forex instruments that cease trading over a weekend. So, if Trade Sunday =
false and Trade Friday = true, then any Run in progress on Friday actually needs the Close-Run function triggered
at least 15 minutes before market closing-time on Friday (see Close For Sunday-Friday Time). This will ensure all
open trades and pending orders are closed before the Friday market close. The Trade Sunday setting can be
changed on-the-fly anytime before its trigger time.

Close For Sunday-Friday Time: ( default = “ignore” )

This setting is activated when Trade Sunday = false. It is important to check the Market-Watch times that the
market is open for your particular broker. Forex trading is normally closed on Fridays by the broker, and any time
set here should be at least 15 minutes before the Friday market close to allow sufficient time for all trade orders to
close. For example, one account we have with GoMarkets in Australia closes on Friday afternoons at the Market-
Watch time of 22:59:59, so in this case we use the setting Close For Sunday Friday Time = 22:30. This setting is
useful to close out orders on Friday afternoon to avoid the weekend gap that shows up at the Sunday evening
market-open. This setting can be changed on-the-fly anytime prior to its trigger time.

Friday Close Time: ( default = “ignore”)

When set to “ignore”, this setting and the next two, Friday Close Profit Only and Friday Close Time Period,
will be ignored, no matter what values they are set to. When set to a close time according to the MetaTrader 4
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Market-Watch time, 08:25, 11:45, or 14:00 as examples, and in the same 24-hour clock 'hh:mm' format, the current
Run will be closed at the specified Friday Close Time unless cancelled or modified by the following two settings.

If the current Run is closed by Friday Close Time and the setting CR Auto-Restart = true, the restart will be
ignored and ForexGM will be stopped and can only be started again manually. This setting is useful to avoid
possible large unexpected price gaps that can occur over the weekend, or simply just to close ForexGM at the end
of the trading week. Depending on activation of the next two settings, Friday Close Profit Only and Friday Close
Time Period, this setting can continue to operate from week to week until it triggers a Close-Run. This setting can
be changed on-the-fly any time before its trigger time.

Friday Close Profit Only:

If set to true, the Run will close at the Friday Close Time set, but ONLY if the current Run net profit of all Main-
Grid and Hedge-Grid trades, both open and closed, is positive either at that exact time, or within the period
specified by Friday Close Time Period. If set to false, then this setting is ignored and the current Run will be
closed immediately at the set Friday Close Time. This setting can continue to operate from week to week until it
triggers a Close-Run. It can be changed on-the-fly any time before its trigger time.

Friday Close Time Period:

This setting works in combination with Friday Close Time and Friday Close Profit Only. If set to zero then this
setting is ignored. If set to 120 minutes for example, it means that during the 120 minute Friday Close Time
Period commencing from the Friday Close Time, ForexGM will monitor the current Run net profit, and will close
the Run if and when it reaches profit within that 120 minute window. Otherwise, the Run will not be closed. Using
Friday Close Time = 14:00 as an example, at 14:00 ForexGM examines the current situation and will immediately
activate a Close-Run if the Run is in profit. If the Run does not go into profit during the set Friday Close Time
Period of minutes, then the Run will continue trading when the market next opens. This setting can continue to
operate from week to week until it triggers a Close-Run. It can be changed on-the-fly any time before its trigger
time.

MISCELLANEOUS INPUTS

The settings in this section apply to the overall strategy.

Lot-Size Normalized: ( default = true)
Whenever Account-Currency is not the same as Quote- 1 NZD = 0.82160 USD | 128315
Currency, a lot-size adjustment that depends upon current iz o e ey
Conversion-pair price might be required. Consider an Stopoutlevel 80% MarginLevel 286565% |
example where Account-currency is USD and the AUDNZD BRIl e
pair is being traded (NZD being the Quote-currency), then
the current price of the Conversion-pair NZDUSD is taken into account when calculating lot-size. A lot-size
adjustment is made immediately at the start of Run 1, and adjustment is also applied at the start of each follow-up
Run according to changes in the NZDUSD price. The Conversion-pair (NZDUSD in this case) must be in the
Market-Watch panel so that current Conversion-pair price is tracked. Not all currency pairs and Account-currencies
are supported yet. If something similar to the above image is seen on the right lower corner of the chart window,
then it indicates that normalization is active and displays the relevant rate used for conversion. When back-testing
in Strategy Tester, Conversion-pair M1 data must also be downloaded or imported into History Center, NZDUSD in
this case. If not present, check in the Experts Log for related error messages.

Show Comments: ( default = true )

ForexGridMaster displays very useful information in comments at the top right corner of a chart, including
Strategy File-Name and Info, Current Run Statistics, Max Equity Drawdown, etc. If Show Comments is set “false”,
then no comments are displayed. The display of comments is also controlled by a parameter in the
ForexGM_Advanced.prf file. If Show Comments is set to “true” or “false”, it will take precedence over any option
set in the Profile.

Log Activity: ( default = true )

The default is set “true” to allow extra information to be saved to the system log-file in the [MT4 Data
Folder\MQL4\Logs directory. These details can help troubleshoot problems when ForexGridMaster does not
appear to be functioning correctly. When there is a problem, log-file entries can be viewed in the “Experts” tab at
the bottom of the Terminal window. Right click on an entry and choose “Open” to view the whole log-file for that
day or any previous days.

Log Debug Info: ( default = false )
Like the setting above, this input can be set to “true” to record even more detail in the system log-file saved at
the [MT4 Data Folder\MQL4\Logs. See Testing and Problem Solving below for more information.
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SPIKE CONTROL INPUTS

In ForexGM parlance, a “spike” occurs whenever a preset limit for either price-range or number-of-trades is
reached within a predefined period. Note that a Spike is handled quite differently for the Main-Grid and the Hedge-
Grid. It is possible to configure ForexGM to open a Hedge-Grid on a Spike, and pause or close the Main-Grid at the
same time. There are many subtleties in the use of this Spike Protection mechanism. It is strongly recommended
to experiment with various scenarios in the Strategy Tester before applying the techniques to a live account.

Spike Option: ( default = Spike-Main-Off )

@ Spike-Main-Off — This setting will disable all spike actions related to the Main-Grid. It does not influence
the Spike Hedge Options which are quite independent.

@ Pause-While-Active — There are several options that cause ForexGM to Pause. What differentiates them
is the manner in which the Pause is cancelled and processing continues. With this particular option,
processing continues after the spike condition no longer exists. See illustration in Figure #1

@ Pause-Until-Reset — When a Spike is detected, a Cancel Spike button appears on the lower right of a
chart. If this option is chosen, the only method of cancelling the Pause is with this button. See illustration in
Figure #3.

@ Pause-Until-Retrace — This option allows a Pause to automatically reset after the price retreats a set
number of pips from either the maximum or minimum price, depending on whether a spike-up or spike-
down is in play. It requires the input Spike Pause Retrace Pips to be set. See illustration in Figure #4.

@ Close-Main — If a strategy requires the Main-Grid to be closed when a spike is detected, this option is set.
Note that the following Close-Run option will also close the Main-Grid and the Hedge-Grid as well.

@ Close-Run — This option closes the Main-Grid and also the Hedge-Grid if it is active.

Spike Hedge Option: ( default = Spike-Hedge-Off )
@ Spike-Hedge-Off — If this is set, a spike has no influence on a Hedge-Grid.

@ Open-Hedge-On-Spike — A spike can be set to trigger the opening of a Hedge-Grid when it is an upward-
spike, a downward-spike or either of these. This option will open a Hedge-Grid for either type of spike.

@ Open-Hedge-On-Spike-Up — A Hedge-Grid will open only when a spike-up is detected.
@ Open-Hedge-On-Spike-Down — A Hedge-Grid will open only when a spike-down is detected.

Spike Interval Seconds:

This parameter specifies the period of time in seconds back from the current time that monitoring takes place,
checking to see if Spike Pips per Interval and Spike Trades per Interval thresholds have been reached. A value
for Spike Interval Seconds between 5 seconds and 86400 (24 hours) is required if either Spike Option or Spike
Hedge Option is enabled. For example, if set to the 990 seconds (16.5 minutes) with Spike Pips per Interval = 30
pips and Spike Trades per Interval = 5, then ForexGM examines the price-range and number of trades within the
preceding 990 seconds. If 5 trades have been opened or the price-range reaches 30 pips, a spike is registered.
The action to be taken when a spike is detected is determined by the values set for Spike Option and Spike
Hedge Option.

Spike Pips per Interval:

If set to the default zero, ForexGM does not monitor the price-range to determine if a spike has occurred. Note
that Spike Pips per Interval and Spike Trades per Interval cannot both be zero when Spike Options are set. If
both methods are used, the first to reach its respective threshold will trigger a spike.

Spike Trades per Interval:

If Spike Options are set and Spike Pips per Interval = 0, this parameter is required. Valid values for Spike
Trades per Interval are from 2 to 50. If set to a value such as 3 for example, this means that no more than 3 trade
orders can be opened within the time period specified by the previous Spike Interval Seconds setting, and the
opening of order number 3 will trigger a spike. These Spike Protection settings are used to counteract large price
spikes and swings by reducing the number of accumulated negative trades. Please note that the tally of open
trades includes those in both profit and loss. This setting can be changed on-the-fly, but exercise extreme caution
to avoid setting values that will immediately trigger a spike.

Spike Pause Retrace Pips:

If Spike Option = Pause-Until-Retrace, this parameter specifies the number of pips the price must retrace from
the price the spike was triggered, before continuing after a pause. This can be any value, but a setting less than
about 6 pips would not be very practical as ForexGM would continue almost immediately after a pause.
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Figure #1: This image shows ForexGM running in the Strategy Tester with Spike Option = Pause While Active;,
Spike Interval Second = 3600; Spike Pips per Interval = 40; Spike Trades per Interval = 0. The grey rectangle
stretches from the current tester-time back 60 bars (or minutes) and maintains that relationship as the time-line
advances. The top and bottom of the rectangle are set to be 40 pips apart, centered around the average price
during the previous 3600 seconds, and surrounding the candles within. When the price range within the rectangle
reaches 40 pips, a spike is triggered which displays the status as shown in the next figure.
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Figure #2: When a Pause has been triggered, there are several visual cues to indicate the status. The cyan text-
box on the upper-left of the chart shows the type of spike that occurred, Pause While Active in this case. The red
text-box on the upper-right is a general message that displays when trading is paused or halted for any reason. If
left running, the Pause would terminate when the price-range fell below the 40 pips set in this example, and allow
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trading to continue as normal. Some Spike Options provide an opportunity to intervene and prematurely cancel the
Pause. Pressing the Cancel Spike button will continue trading, and once again monitor for a new spike condition.
Note that the Cancel Button is not operational in the Strategy Tester. The outer dark-blue rectangle in the figure
shows the price-range over the spike-period, and the inner cyan rectangle illustrates the level that will reset the
Pause. When these two rectangles converge, normal service is resumed.
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Account Equity = AU$9,592 / Chart Equity = AUS4,793
Current Run Net Profit = AUS-6.88 (-0.14%)
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Figure #3: The Spike Options here are the same as for the previous figures above, except for Spike Option =
Pause Until Reset. The dark-blue rectangle stretches from the time the spike was first triggered to the current
time. ForexGM will remain Paused until the Cancel Spike button is pressed. The Pause will take precedence and
cause ForexGM to ignore any conditions that might otherwise cause a Stop-Run.
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Figure #4: This image illustrates a strategy that has spike detection set for a 30 pip range in a 60 minute window,
Spike Option = Pause Until Retrace and Spike Pause Retrace Pips = 25. The left side of the dark-blue
rectangle indicates where spike detection started, and the cyan line shows the retrace price that will cancel the
Pause. The vertical yellow line has been added to show the time the actual spike was detected. Normally this point
would be 60 minutes after the start of the monitoring interval, but because a Stop-Run occurred within the previous
60 minutes, the Stop-Run time becomes the temporary start of the monitoring interval. In this case, the spike is
downwards, and the retrace price is 25 pips above the minimum price since the spike occurred. Notice that
absence of grid-lines after the spike is detected. As with other Spike Options, this Pause can be cancelled by
pressing the Cancel Spike button.

AUTO-RESTART OPTIONS

Auto Restart After Profit [ ARAP ]: ( default = Restart-Enabled )
Auto Restart After Loss [ ARAL ]: ( default = Restart-Enabled )

Previous versions of ForexGM allowed automatic restarts after Runs were closed. In this version we extend that
functionality to include different actions depending on whether a previous Run has been closed is in Profit or in
Loss. If either ARAP or ARAL is triggered by the respective profit or loss Close-Run, and the related option is set
Restart-Disabled, ForexGM will require manual intervention before the next Run commences. The following
options apply for both ARAP profit-closes and ARAL loss-closes, quite independent of each other. These settings
can be changed on-the-fly.

@ Restart-Enabled — This option will cause ForexGM to restart automatically after a Close-Run. If Restart
Seconds Delay is zero, the new Run will commence immediately. Otherwise, it will delay the restart for the
specified period.

@ Restart-Disabled — A Close-Run with this option selected will pause ForexGM and display a red text-box
on the upper-right of the chart to indicate the pause status, and a FGM RESTART button will appear on the
lower-right. As might be expected, a press of that button should start the next Run.

@ After-Pips-Movement — A new Run will commence after a price-movement specified by Restart Pips Up
or Down.

@ After-Pips-Retrace — This selection is similar to After Pips Movement and works in conjunction with it, but
in addition requires a price retrace once the threshold has been reached.

Restart Seconds Delay: ( default=0)

This value can be set individually for both the ARAP and ARAL options. When any option other than Restart-
Disabled is selected, Restart Seconds Delay specifies the number of seconds to wait after a Close-Run, before
commencing the next Run. If ARAP or ARAL is set to Restart-Enabled and has the respective Restart Seconds
Delay = 0, the next Run will automatically commence without delay after a Close-Run. If ARAP or ARAL has After-
Pips-Movement or After-Pips-Retrace selected, ForexGM will pause for Restart Seconds Delay before
monitoring for the specific restart condition. In other words, Restart Seconds Delay takes priority over options that
might trigger a restart before the delay period has expired. The maximum value is 36,000 seconds (10 hours). This
setting can be changed on-the-fly.

Restart Pips Up or Down:

After a Close-Run, ForexGM will pause until the price has moved away from the Close-Run price, either
upwards or downwards, by the number of pips specified in Restart Pips Up or Down. If Restart Seconds Delay
is greater than zero, ForexGM will wait that number of seconds before checking the price movement. Restart Pips
Up or Down can have any positive value, but should be greater than about 5 pips to be of practical use. A value of
zero effectively means the setting is ignored. This setting can be changed on-the-fly.

Restart Pips Retrace:

This parameter is required if After-Pips-Retrace is set, and takes effect after a Close-Run where the price has
moved Restart Pips Up or Down from the Close-Run price. Its value must be 5 pips or more. The threshold level
can move beyond that originally set by Restart Pips Up or Down and ForexGM monitors for a price retrace from
the highest (or lowest) threshold. There are some chart graphics to show the behaviour during this period, and
experimenting with various settings in the Strategy Tester is recommended to gain a clear understanding of the
procedure. Horizontal lines are displayed for both thresholds and the trigger price — see Figure #5 for details.
Since this setting only applies after a Stop-Run, it can be changed on-the-fly at any time during an active Run.
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Figure #5: This image illustrates a strategy where Auto Restart After Profit = After-Pips-Retrace, Restart
Seconds Delay is zero, Restart Pips Up or Down = 30, and Restart Pips Retrace = 20. The lower threshold was
hit first, and it follows the price downwards. The cyan-colored line indicates that the trigger has been activated, and
it continually adjusts to be 20 pips above the threshold. When the price moves back up to the trigger price,
ForexGM becomes active and the next Run commences. If it is required to continue trading before the price
reaches the trigger level, press the Cancel Delay button and the next Run will start immediately.
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CLOSE-RUN OPTIONS

The combined net Profit/Loss calculations of the Main-Grid and Hedge-Grid orders within a Run will trigger a
Close-Run when conditions meeting any of the following criteria are met. The Net Profit (Main-Grid plus Hedge-
Grid) is displayed in the ForexGM comments on a chart. A grid Run will be stopped on the next tick after a Close-
Run is triggered, and all orders controlled by the specific ForexGM instance will close. If a Close-Run occurs while
a Hedge-Grid is active, all orders associated with both Main-Grid and Hedge-Grid are closed. The following
parameters specify conditions for Close-Runs that are not visible to the broker, and hence are referred to as
Stealth-Mode settings.

CR Include Closed Trades Net:

Most of the following options depend on a Profit/Loss calculation involving trades made during a particular Run.
This parameter dictates whether or not to include trades that have been closed within the Run. When set to the
default true, the net Profit/Loss calculation includes all related grid-trades that have been closed within a Run. In
other words, when CR Include Closed Trades Net is set false, the calculation of net Profit/Loss involves only open
trades, and not any trades that have been closed within the Run.

CR Total Profit Percent:

If set to the default 0, this input is ignored. Otherwise, it specifies the percentage of equity-profit that will trigger
a Close-Run which closes all open trades and deletes all pending orders. ForexGM Advanced will then
automatically initiate the next Run provided Auto Restart After Profit is enabled. For example, if CR Total Profit
Percent = 3, it means that 3% of the Start Equity for the particular Run is the Close-Run profit target. ForexGM wiill
close the Run when that target is reached. If CR Include Closed Trades Net is set true, the profit calculation
includes all trades closed within that specific grid Run. During trading, the continuously updated Net Profit/Loss
figure is displayed in the chart comments. This figure is calculated independently from all other trades that might
have been placed during the period in question, whether they were placed by ForexGM, other robots, or manually.
Unique EA Numbers are used to identify trades that relate to a specific ForexGM instance. This setting can be
changed on-the-fly, although it can trigger an immediate Close-Run if a profit target has been reached at the time
the change is made.

CR Total Loss Percent:

If set to 0, this input is ignored. If non-zero, it will trigger a Close-Run when the net loss of all open and closed
trades within a Run equals the specified percentage of run-start Chart-Equity. When CR Loss Percent is triggered,
it closes all Grid open trades and deletes all pending orders, and then ForexGM will automatically initiate the next
Run if Auto Restart After Loss is set true. This setting can be changed on-the-fly, but be aware that it can trigger
an immediate Close-Run if a loss target has been reached at the time the change is made.

CR Trail-Stop Percent [ CR-TSP ]:

When the value is set to the default zero, both this input and the following CR-PPBTSP input are ignored. A
non-zero value specifies a trail-stop in terms of run-profit as a percentage of the start-run Chart-Equity. As an
example, suppose CR Trail-Stop Percent = 1.0% and the start-run Chart-Equity is $4,000. The trail-stop would be
$40, and the Run would close if the profit fell $40 below the peak profit for the Run. This setting can be changed
on-the-fly, but it is important to note that it is only applied at the start of a Run and has no effect during a Run.

CR Profit Percent Before TSP [ CR-PPBTSP ]

This parameter works in conjunction with CR Trail-Stop Percent. If it is zero, a percent trail-stop is activated
when the Run begins. If non-zero, the percent trail-stop will kick in when Run profit reaches the CR-PPBTSP
percentage of the start-run Chart-Equity, and applies until the Run closes. If CR-PPBTSP = 0.5% as an example,
then equity must increase by 0.5% before the CR Trail-Stop Percent input is triggered. The profit used in the
calculation is the net profit of all open trades, plus the net profit of trades closed during that specific grid Run (if CR
Include Closed Trades Net is set true). This setting can be changed on-the-fly, but as with CR Trail-Stop
Percent, it is only applied at the start of a Run..

CR Loss Money:

This setting is very similar to CR Loss Percent except that the trigger-level for a Close-Run is specified as a
monetary amount rather than a percentage of Chart-Equity. It is useful if a trader wishes to limit the loss on a
particular Run to a certain amount. The loss-calculation includes both Main-Grid and Hedge-Grid trades if a Hedge-
Grid was active during the Run. It can be changed on-the-fly.

CR Trail-Stop Money: [ CR-TSM ]

This setting is very similar to CR Trail-Stop Percent except that when CR Profit Money Before TSM (below) is
set to the default zero, this input is ignored. It is also ignored if CR Trail-Stop Percent is set because both these
options cannot be active at the same time. When CR-PMBTSM is set to a monetary value, $3,000 as an example,
this input is enabled. If CR-TSM = $500, then when profit reaches $3,000, the $500 trail-stop is activated and a
$2,500 profit is locked in. As profit increases further, the trail-stop will trail dollar-by-dollar (or whatever base
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currency the account uses) — at $3001 a profit of $2,501 profit is locked in. Profit is calculated for all orders
associated with the particular grid Run. This setting can be changed on-the-fly.

CR Profit Money Before TSM: [ CR-PMBTSM ]

When set to the default zero, this parameter and CR Trail-Stop Money are ignored. It should not be enabled if
CR Trail-Stop Percent is set. As illustrated in the previous paragraph, this setting specifies the trigger-level
(monetary Run-profit value) to be reached before the trail-stop money is activated. This setting can be changed on-
the-fly.

CR Profit Pips:

If set to the default zero then this input is ignored. When set to a pips number value (whole pips only, no
fractions), this input specifies the number of pips profit that will cause a Close-Run. For example, if a strategy has
CR Profit Pips = 150, this means that 150 pips is the Run target. ForexGM will close the Run when it reaches 150
pips in profit target, and a new Run will start immediately (unless Auto Restart After Profit is disabled). The 150
pips target is calculated from the net value of all open trades, plus the net profit of trades closed within that specific
Run (except if CR Include Closed Trades Net is set false, and only the open trades are taken into account). If
Show Comments is set true, the Net Profit Pips figure is displayed on the chart. This setting can be changed on-
the-fly.

CR Loss Pips:

If set to the default zero, this input is ignored. For any positive value, this input results in a Close-Run when the
net pips loss of all open and closed trades within the Run reaches this level. However, if CR Include Closed
Trades Net is set false, and only the open trades are taken into account. The pip calculation does not include any
trades unrelated to the specific ForexGM instance. A unique EA Number is assigned to each ForexGM instance to
identify related transactions and trades. This setting can be changed on-the-fly.

CR Trail-Stop Pips:

If set to default O pips, then this setting is ignored. For any other value, either positive or negative, this setting
specifies the Close-Run price threshold in pips. When a Run starts, the threshold is set above or below current Bid
price at that time — above the Bid price if a positive number, below if a negative number. As an example, consider a
current EURUSD price of 1.3095 and CR Trail-Stop Pips = 20. When the price moves down, the stop-loss will
follow it down and remain 20 pips above the Bid price. As the price retraces and moves upwards, the threshold
remains fixed and a Close-Run is triggered when the price reaches that threshold price level. If CR Trail-Stop Pips
was negative, the effect would be in the opposite direction, with the threshold adjusted to be 20 pips below the Buy
price for an upward price movement. Extra care should be taken when combining CR Trail-Stop Pips with any of
the Auto-Restart options. This setting can be changed on-the-fly.

CR Hedge Profit Percent:

This setting is similar to CR Total Profit Percent, but here the profit is calculated by taking only the Hedge
trades into account. When the total profit for Hedge trades during the Run has reached CR Hedge Profit Percent,
a Close-Run is actioned. If set to the default 0, this input is ignored. Otherwise, it specifies the percentage of
equity-profit that will trigger a Close-Run which closes all open trades and deletes all pending orders. ForexGM
Advanced will then automatically initiate the next Run provided Auto Restart After Profit is enabled. As an
example, if CR Hedge Profit Percent = 3, it means that 3% of the Start Equity for the particular Run is the Close-
Run profit target. ForexGM will close the Run when that target is reached. If CR Include Closed Trades Net is set
true, the profit calculation includes all trades closed within that specific grid Run. This setting can be changed on-
the-fly, although it can trigger an immediate Close-Run if a profit target has been reached at the time the change is
made.

CR Hedge Loss Percent:

If set to 0, this input is ignored. If non-zero, it will trigger a Close-Run when the net loss of all open and closed
Hedge trades within a Run equals the specified percentage of run-start Chart-Equity. When CR Hedge Loss
Percent is ftriggered, it closes all Grid open trades and deletes all pending orders, and then ForexGM will
automatically initiate the next Run if Auto Restart After Loss is set true. This setting can be changed on-the-fly,
but be aware that it can trigger an immediate Close-Run if a loss target has been reached at the time any
modifications are saved via the Settings Panel.

CR Price Maximum:
CR Price Minimum:

These two inputs can be set independently, and are ignored if set to the default zero. Set to a specific price
above or below the prevailing Bid price as appropriate, a Close-Run is actioned when the Bid price hits either
threshold level. It is important to note that these settings should only be used in a short-term monitoring situation,
and manual intervention is required before the following Run can commence. They should NEVER be used in
conjunction with any Auto-Restart options as the results could be unpredictable, and potentially disastrous. This
setting can be changed on-the-fly.
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IMMEDIATE-CLOSE OPTIONS

These settings are used to immediately close some of or all trade orders controlled by this instance of ForexGM
and its EA Number. A close procedure is actioned as soon as one of these options is selected in the Settings
Panel and the OK button is clicked. To resume trading after the trades have closed, it is necessary to return to the
Settings Panel and deselect the previous close-option. A Red text-box displays a message on the top-right of the
chart as a constant reminder that ForexGM requires a reset before normal trading resumes. Settings in this section
specify which particular grid-orders should be closed, resulting in either a full or partial Close-Run.

A full Close-Run occurs when the chosen options result in the closure of all trades and pending orders. A
colored rectangle (the Close-Run marker) is drawn on the chart to identify a full Close-Run, and the upper and
lower boundaries will usually correspond to the highest and lowest prices of trades placed within the Run. Hovering
over this marker will show the equity and profit/loss associated with the Run. Full Close-Runs are numbered 1, 2, 3
etc. For partial Close-Runs, letters are appended to the run-numbers... 1-A, 1-B, 1-C, etc.

It is important to exercise caution for partial Run-Closes when either Main Grid Order Replacement or Hedge
Grid Order Replacement is set true. The situation might arise where an order is deleted, and is immediately
replaced when the grid becomes active again. These settings apply only at the time ForexGM is restarted via the
Settings Panel, and hence can be changed on-the-fly.

Trades can be closed using various techniques available in the MetaTrader terminal, but note that if trades are
closed outside the control of ForexGM, the accounting data will no longer be reliable.

Close Greater-Profit-Than:
Close Greater-Loss-Than:

These settings are only enabled when set to a positive, non-zero value, and Close Orders Now = Close-At-
Specified-Profit-Loss. As an example, if Close Greater-Loss-Than is set to 100 and the base account currency
is USD, only trades showing a loss of US$100 or more will be closed.

Close Grid-Type: ( Main-and-Hedge, Main-Grid-Only, Hedge-Grid-Only )

This parameter works in conjunction with the Close Orders Now option. If set to the default Main-and-Hedge,
all grid orders will be included when assessing the criteria to determine which trades to close. If Hedge-Grid-Only
is selected for example, Main-Grid trades will be filtered out and only Hedge-Grid trades would be involved.

Close Orders-Type: ( Buys-and-Sells, Buys-Only, Sells-Only )

As with the previous parameter, this works in conjunction with the Close Orders Now option. If set to the
default Buys-and-Sells, all order types will be included when assessing the criteria to determine which trades to
close. Somewhat expectedly, if Sells-Only is selected it means only Sell trades would be included.

Close Orders Now: ( default = Close_None )

Close-None — Continue trading as normal

Delete-Pending — Only delete Pending Orders

Close-Trades — Close Open Trades

Close-At-Specified-Profit-Loss — Close trades that have profit/loss outside the limits (above)
Close-Run-Now — Close all trades matching the Close Grid-Type and Close Orders-Type criteria

oo

If Delete-Pending is set, be aware that no new pending orders will be placed until after the next full Close-Run.
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Fixed-Center and Moving-Center Scenarios

Fixed-Center Grid
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Figure #6: This image illustrates a Fixed-Center grid run in Strategy Tester with the settings below. The equity
graph is also included to demonstrate a useful technique for comparing the profitability of various strategies.
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As the price moves out from the fixed center-line, Sell-Limit and Buy-Limit orders are placed and opened when
the prices reach the appropriate levels. With these settings, only one pending order is placed in each direction.
Individual trades are closed by the Trail-Stops. The Run will close once the profit has reached the target 0.80% of
Chart-Equity (or more) followed by a drop of 0.15% from that threshold.
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Moving-Center Grid
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Figure #7: This image shows snapshots at three different positions along the time-line to illustrate how the moving
center is adjusted as price moves, and keeps orders outside the excluded center-zone.

The following settings were used to produce the result shown. The best way to understand how the Moving-
Center works is to use settings similar to these and run a test or two in the Strategy Tester.

Main Grid Moving-Center
Main Order Type Buy-Sell

Main Trend Direction Counter-Trend
Main Grid Spacing 10

Main Max Pending Buy Orders 2
Main Max Pending Sell Orders 2

Main Center-Zone Pips 30
Main Take-Profit Pips 30
Main Stop-Loss Pips 10

In section #1 of Figure #7, the Buy and Sell pending orders are placed symmetrically around the center-line price
set when the Run started. The dull-red band is an indication that the Center-Zone extends 15 pips either side of the
center-line where orders cannot be placed. As the price moves down in section #2, a Buy is opened at the Buy-
Limit. This does not change the center-line or trigger adjustment of other grid orders. However, the price turns
back up and closes this Buy trade on a Take-Profit target. This leaves a gap between the lowest Sell-Limit and the
highest Buy-Limit of 40 pips, i.e. greater than the 30 pips set for Center-Zone. To correct the situation, the top Sell-
Limit is relocated as close as possible to the current Bid price resulting in a shift downwards of the center-line.

In section #3, the price continues its upwards movement, opening Sells and adding Sell-Limits along the way. In
the lower portion of the grid, Buy trades are being closed at Take-Profit targets and new Buy-Limits added as
appropriate. The end result is that the center-line moves roughly in sync with the currency-pair price.
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Grid Runs... The Magic at the Heart of ForexGridMaster

MainGrid and HedgeGrid Runs

When ForexGridMaster is initiated on a chart, no matter what the preset-file strategy settings are, grid Run #1
starts and pending orders are placed on the broker's MetaTrader4 server according to those settings chosen by
trader. The only exception to this initial placement of pending orders, is when a delayed-start is dictated by the
Auto-Restart parameters.

The philosophy that drives ForexGM is to break trading into blocks of trades, or Runs. A Run will close all trades
and delete all pending orders when certain criteria have been met. These Run-Closes are controlled by carefully
configured parameters that should produce the various desired outcomes — profit-targets, loss-limits, hedging,
restart-delays, spike-response, and others as detailed in earlier sections.

Successful Forex trading relies heavily on visual aspects of the trading-terminal to help identify endless patterns
in price movements that could lead to profitability. ForexGM extends the graphics built into MetaTrader4, with the
aim of placing graphics in a meaningful context to convey the maximum amount of useful information. Spike-
detection is one area where we have pushed the graphic 'envelope’ to its limit. We also recognize the importance
of back-testing various strategies before committing funds. The following screen-shot from a Strategy Tester Run
illustrates how the Runs are marked on a chart, plus a few visual cues as the what might have caused the
particular Run to close.
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Figure #8: In this particularly busy screen-shot, we have attempted to capture several of the graphical features that
are unique to ForexGM. The Green rectangles mark the end of a Run. Those shown here are colored Green
because the three Runs were all closed in profit. If a Run is closed in loss, the rectangle would be Red. If desired,
these default colors can be changed by setting values in the Profile. Hovering over the bars above and below the
rectangles will display tooltips giving details about the associated Run.

A small icon is added to indicate where pending-orders are actually opened. In Strategy Tester, this feature is not
of much benefit because the point pending-orders are opened is already marked with a small arrow. However, in
Demo or Live mode, no arrow is drawn to indicate the opening of an order, so the additional icons can be extremely
useful. Blue icons indicate Buy orders, and red for Sells. The strategy illustrated has a Main-Grid with Fixed-
Center, which produces the horizontal blue lines marking grid center-price and the outer grid-slots that would be
occupied if the maximum number of grid positions were filled. There are several other situations that result in
horizontal lines to indicate various significant price levels. Hover over any line and the tooltip should identify its
function.
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Profile ForexGM_Advanced.prf — Alerts, Objects, Chart Display

The ForexGM_Advanced.prf file is optional, and to take effect it should be placed in both these folders -- “[MT4
Data Folder]\MQL4\Files” and “[MT4 Data Folder]\tester\files”. ForexGM can run with the ForexGM_Advanced.prf
file using its default values, but there are many settings that might be customized to suit personal preferences.
Changes made to these prf files affect all instances of ForexGM running in a terminal. Note that the Strategy Tester
profile is separate from the profile in the normal run environment. Any new ForexGM instance will automatically
adopt the appropriate profile once it is set up.

Some options allow an email to be sent when an Alert is triggered. This requires additional MetaTrader4
terminal configuration. In the menu, Select Tools > Options > Email, and enter the required details. Only one email
address can be used and this applies for all Alerts sent from ForexGM. If you wish to customize the sounds for
various Alerts, load the required sound-files into the [MT4 Data Folder]\Sounds folder and modify the relevant
references in the Profile.

The following fields are typical entries in ForexGM_Advanced.prf. Please take care to include the semi-colon
(%;”) at the end of each line and before any comment delimiter (“//”). If the value of any field is set “default”,
ForexGM will use the relevant default value built into the software. Some fields appear in the Settings as well as in
the Profile. In this case, any non-default value in Settings will take precedence over the value in the Profile.

Fields referring to colors can use any of the following formats...

Web-color Names: clrMediumBlue
Hex Format: 0x665544 ( 0xBBGGR )
RGB Format: 20,30,40 (rr,gg,bb)
@ ShowComments = default;
d TextSize =9;
@ TextColor = clrYellow;
@ ChartBackgroundDark = true;

There are two default styles built into ForexGM — one with a light-coloured theme, the other dark.
Experiment with this field set to 'false' if you prefer a light background.

@ CenterLineColor = clrSteelBlue;
@ CenterZoneColor = default;

@ TrailPriceColor = default;

@ CloseBarlnitialColor = default;

@ CloseBarPartialColor = 85,85,143;
@ CloseBarProfitColor = default;

& CloseBarlLossColor = default;

@ LogActivity = true;

@ LogDebuglinfo = default;

@ AfterMarginLimitResume = true;

When there is a Margin-Call on an Account, ForexGM pauses. With this field set true, ForexGM will
continue trading if the Account Equity increases so that the Margin is again within limits. If set false,
ForexGM will need manual intervention for trading to continue after a Margin-Call has been triggered.

& TestCommission = 0.00;
This parameter simulates Commission when using the Strategy Tester. A value of 7.00 would represent a
return-trip Commission of 7.00 units of Account Currency per lot.

@ AccountNameTester = Joe Trader;
If the MetaTrader4 Terminal is disconnected from the broker, it is often difficult to obtain the Account-Name.
This name is required for ForexGM licensing. In order to use the Strategy Tester in off-line mode, enter the
full name of the account in this field.
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Alerts related to parameters in the following group will fire every time the particular trigger-event occurs.

& AlertRunClosedSound = true;
@ AlertRunClosedPopup = false;
@ AlertRunClosedEmail = false;
@ AlertSpikeSound = true;
@ AlertSpikePopup = false;
@ AlertSpikeEmail = false;

The following three fields will produce an Alert only once when the trigger event first occurs, and will be reset to
fire again after the MetaTrader terminal is restarted or ForexGM is reloaded.

@ AlertMarginWarningSound = true;
@ AlertMarginWarningPopup = false;
@ AlertMarginWarningEmail = false;

A zero value for any of the following parameters will disable the particular Alert. Each of the Alerts in this group
will only fire once per Run. Additionally, these Alerts will be reset whenever the EA or terminal is restarted. Note
that any change of chart-period will also cause a reset of these Alerts.

AlertTotalBuysOpenSound = 0; // ( set the total number of Buys that will trigger Alert )
AlertTotalBuysOpenPopup =0;
AlertTotalBuysOpenEmail =0;
AlertTotalSellsOpenSound = 0; /I ( set the total number of Sells that will trigger Alert )

AlertTotalSellsOpenPopup =0;
AlertTotalSellsOpenEmail =0;
AlertHedgeOrderOpenBuysSound = 0; // ( set the number of Hedge Buys that will trigger Alert )
AlertHedgeOrderOpenBuysPopup =0;
AlertHedgeOrderOpenBuysEmail =0;
AlertHedgeOrderOpenSellsSound = 0; // ( set the number of Hedge Sells that will trigger Alert )
AlertHedgeOrderOpenSellsPopup =0;
AlertHedgeOrderOpenSellsEmail =0;

OOV

For each Alert involving Sound, the following fields can be used to customise the sounds related to each event.

@ SoundinputError = expert.wav;
@ SoundRunClosed = alert2.wav;
@ SoundSpike = alert.wav;
@ SoundBuysOpen = alert.wav;
@ SoundSellsOpen = alert.wav;
@ SoundMarginWarning = alert.wav;
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ForexGM Chart Comments

An example in Strategy Tester ...

EURAUD,M1 1
EA-Numbes

Strategy: fgm-default_audnzd_bsct5-s0.1_tot69

Details: Isp.0001-ip12_tp13-s0.2_crppbts0.6-ts0.1

fffffffffffffffffffffffff o~~~ — Account Equity =AU%$9,721 / Chart Equity = AU$4,855 |, ...,
Run 1 Start Equity = AU$4,800 on 2017.07.25 at 00:00

Run 1 to Run 2 Net Profit = AU$132.03 (2.75%) | ¥

Run 3 Start Equity = AU$4,866 on 2017.07.26 at 07:44 |, ...,
- — Current-Run Net-Profit = AU$-11.24-0:23%)

Drawdown = 6.39% (AU$307) on 2017.07.25 at 11:05 | .amss
Min Chart Equity = AU%4,4937 Min MarginLevel = 1665%

ProfitPercent BTS = 0.80% and TrailStop = 0.15% [14m0

147545

147410

MainGrid Buys: 3, Lots 0.06 / Sells: 0, Lots 0.00
HedgeGrid Buys: 1, Lots 0.10 / Sells: 3, Lots 0.36 fi4m0

topoutLevel: 100% MarginLevel

263ul2017 2610638 261ul06:46 26Jul06:54 260702 261l07:10 26l07:18 2610726 26Wl07:34 2610742 26Tl 07:50 261ul07:58 26 Tul08:06 26 ul08:14 26 1ul08:22 26 Jul08:30 26 Jul 0838

Figure #9: Chart Comments are completely dynamic and refreshed every tick. Some lines display only when
certain parameters are set, for example the Profit-Percent/Trail-Stop comment-line shown above. In certain
situations, a line might be highlighted or displayed in bold-font. Taking Profit-Percent/Trail-Stop again as an
example, when the threshold ProfitPercent BTS is reached, the related comment-line is drawn in bold-font and the
new threshold value is updated if pushed higher.

COoLoeooooooooovooOOoOCOOCVOE
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Strategy: A free-form entry copied from the Settings-field that identifies set-file name and function

Details: Another free-form field that could be used to display extra information about a strategy

Account Equity/Chart Equity: Displays the split between Account-Equity and Chart-Equity

Account Details at Run 1 Start: Original starting Chart-Equity plus date and time

Net Profit Preceding Runs: Total Profit/Loss for previous Runs (money and percent) — useful for analysis
Current Run Start Equity: Chart-Equity plus Date and Time at the start of the current Run

Current Run Net Profit: Profit/Loss (money and percent) of current Run — updated tick-by-tick

Drawdown: Maximum drawdown (money and percent) over all Runs, plus Date and Time of drawdown
Minimum Chart Equity / Margin Level: Displays in Strategy Tester to facilitate risk assessment

Profit Percent BTS: Details displayed if CR Trail-Stop Percent and CR Profit Percent Before TSP set

Loss Limit: Displays the Loss Limit (money and percent) if CR Loss Percent is set

MainGrid Buys/Sells: When the Main-Grid is active, this line displays the number of open Buy and Sell
trades associated with the Main-Grid, and the total lot-size for each order-type

HedgeGrid Buys/Sells: When the Hedge-Grid is active, this line displays the number of open Buy and Sell
trades associated with the Hedge-Grid, and the total lot-size for each order-type
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Testing and Problem Solving

When ForexGridMaster fails to function as you expect, it's time to investigate if your expectations are correctly
aligned with the product, or whether a bug exists in the system that should be brought to the attention of our
developers. First step is to carefully check the settings in the Properties Panel to ensure all inputs are properly
configured and compatible with each other. No effort has been spared in preparing this manual to explain the
subtleties and finer points of ForexGM, so please make good use of it.

By default, ForexGM specific error-messages are written to the log-file accessible through the “Experts” tab.
Errors related to broker communication or transaction processing usually appear in the “Journal” tab. In the
MetaTrader4 terminal, both these tabs are displayed below the chart window when the control-panel is visible. A
new log file is created each day, and there are various techniques for retrieving information from earlier logs —
please check the MT4 help files for details.

Some problems occurring in software (and hardware) might never be resolved because the problems cannot be
reliably reproduced. When reporting a problem with ForexGM, please make every effort to provide sufficient
information for us to recreate the problem. The level of debug information collected by ForexGM is controlled by
the Log-Activity and Log-Debuglinfo entries in both the Profile (prf file) and the Settings. The Settings related to a
particular ForexGM instance take priority over any parameters in the Profile, so set both these parameters to 'true’
in the Properties Panel to output all information that might provide clues in tracking down possible bugs.

Here is a broad checklist of steps to follow when you wish to report an ForexGM problem to Support...

@ Close all open and pending trade orders -- either close manually or use the Close-All-Now option

@ Remove ForexGM Advanced -- right-click on the chart Popup > Expert Advisors > Remove

@ Delete all Global Variables -- Go to menu Tools > Global Variables > Select all > Delete.

@ Delete all Objects from the chart -- right-click on chart Popup > Objects List > Select all > Delete

& Close the MetaTrader4 terminal

& Restart the MetaTrader4 terminal

@ Load ForexGM on the chart -- drag-n-drop ForexGM from the Navigator Panel, or select chart and double-
click ForexGM

@ Configure the settings you want in ForexGM Properties Panel > Inputs tab, consult the manual for settings
info

@ In Properties Panel click Save and name/save the preset-file, usually to [MT4 Data Folder]\MQL4\Presets\

@ Click OK to activate ForexGM Advanced

If ForexGM Advanced still does not operate the way you expect, please do this ...

@ Send us the related preset-file previously saved to the [MT4 Data Folder]\MQL4\Presets\ folder

@ Send us the relevant Experts log-file from [MT4 Data Folder\MQL4\Logs\

@ If the problem is visible on the chart, go to main menu File > Save as Picture... > Active Chart (as is)
@ Describe what happened as best you can, and also provide the appropriate information listed below

The above procedure solves 95% of all reported ForexGM problems. Some of the remaining 5% could be due a
corrupted MT4 program (not because of ForexGM), and this is usually fixed by a re-install of the MT4 software.

Please provide some or all (if appropriate) of the following information when reporting a problem to us ...

Name of Broker

Account Type -- Micro, Mini or Standard account

Account Leverage -- 100:1, 200:1, 500:1, etc.

Run Environment -- Back-testing in Strategy Tester; Live or Demo account

Account Balance, Account Equity and Margin level

MetaTrader4 Release and Build Number ( see main menu Help > About... )

Does ForexGM show a smiley-face, and is it red?

Is the problem related to a specific time-frame? If so, which one?

Are there other instances of ForexGM or other EAs trading on the same terminal? If so, details please
Attach the relevant preset “.set” file/s -- these are most important as they allow us to recreate the problem
Attach Experts and Journal log-files, or copy/paste relevant sections into the email.

COLoeooooeooeooovooOOoVO
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@ Edit the Settings and set Log-Activity = true and Log-Debuginfo = true, and run the strategy again to see
if more details can be obtained about the problem. If the log-files show additional information related to the
problem, please include this latest log with the problem-report you submit to us.

@ If appropriate, include a copy of the Account Statement accessed from the “History” tab on the control-panel
at the bottom of the terminal. Right click in the History entries, select the reporting-period, and then choose
“Save as Detailed Report”.

@ It might also help in diagnosing the problem to send us an image of the chart running ForexGM at the time
the problem occurred. From the main menu... File > Save As Picture...

@ Please be thorough and include any additional information that might be helpful

ALL TRADING INVOLVES RISK OF LOSS Trading in the Off-Exchange Retail Foreign Currency Market
(FOREX) can be one of the riskiest forms of investment in the financial markets due to the high leverage
provided by most brokers, and therefore is best suited for sophisticated individuals and institutions. Because of
the potential to lose all funds invested, one should never invest money that one cannot afford to lose.

Nothing in this document is a recommendation to buy or sell currencies, and no ForexGridMaster employees or
associates are liable for any loss or damage, including without limitation, any loss of profit or funds invested,
which may arise directly or indirectly from the use of ForexGridMaster such as, but not limited to... trading-
robots, tools, information, etc. or reliance on such information.

Past performance does not guarantee future results, and this refers also to all past performance illustrated on
the ForexGridMaster web-site. Every investor should seek professional advice regarding the suitability of
ForexGridMaster for the investor's personal needs and circumstances.
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